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Les symboles ci-dessus avertissent l’utilisateur des dangers
potentiels découlant d’une mauvaise utilisation d’appareils
électriques. Le symbole de l’éclair placé dans un triangle
équilatéral indique la présence de tensions électriques
pouvant provoquer des risques d’électrocution. Le symbo-
le du point d’exclamation souligne des consignes d’utilisa-
tion ou de sécurité à respecter.

Ces symboles vous indiquent qu’aucune des pièces
internes de l’appareil n’est réparable par l’utilisateur.
N’ouvrez pas l’appareil. Ne tentez pas de réparer l’appareil
par vous-même. Confiez toutes les réparations à un tech-
nicien qualifié. L’ouverture de l’appareil annulerait la garan-
tie fabricant. Ne laissez pas l’appareil à proximité de
liquides. Si du liquide s’est infiltré dans l’appareil, éteignez
immédiatement ce dernier et confiez-le à votre revendeur.
Débranchez l’appareil par temps d’orage.

AT T E N T I O NT E N T I O N
RISQUE D'ÉLECTROCUTION

NE PAS OUVRIR

 :  RISQUE D'ÉLECTROCUTION NE PAS OUVRIR

ATTENTION :  Pour éviter tout risque d'électrocution ou d'incendie, ne pas 
exposer cet appareil à la pluie ou à l'humidité 

CONSIGNES DE SÉCURITÉ

NOTE POUR CLIENTS DONT L’APPAREIL EST ÉQUIPÉ D’UN
CORDON D’ALIMENTATION.

AVERTISSEMENT : CET APPAREIL DOIT ÊTRE RELIÉ À LA
TERRE.

Les conducteurs du cordon secteur présentent le code couleur sui-
vant :

VERT et JAUNE - Terre        BLEU - Neutre        MARRON - Phase

Il se peut que le code couleur ci-dessus ne corresponde pas à celui
de votre cordon secteur. Dans ce cas, veuillez suivre la procédure ci-
dessous :

• Le conducteur vert et jaune doit être relié à la borne de la fiche
repérée par la lettre E, par le symbole de terre ou par la cou-
leur vert ou vert- jaune.

• Le conducteur bleu doit être relié à la borne de la fiche repérée
par la lettre N ou la couleur noire.

• Le conducteur marron doit être relié à la borne repérée par la
lettre L ou par la couleur rouge. 

Cet appareil peut nécessiter un cordon secteur et/ou une fiche sec-
teur différent(e) en fonction de l’installation électrique de votre domi-
cile. Faites toujours remplacer la fiche du cordon électrique par un
technicien qualifié. Celui-ci devra reprendre les réglages indiqués
dans le tableau ci-dessous. Le conducteur vert/jaune doit être relié
directement au boîtier de l’appareil. 

PILE AU LITHIUM
AVERTISSEMENT

CAUTION!
This product may contain a lithium battery.There is dan-
ger of explosion if the battery is incorrectly replaced.
Replace only with an Eveready CR 2032 or equivalent.
Make sure the battery is installed with the correct pola-
rity. Discard used batteries according to manufacturer’s
instructions.
ATTENTION !
Cet appareil est équipé d’une pile au lithium. Une mau-
vaise manipulation lors de son échange peut provoquer
un risque d’explosion. Remplacez-la par une pile de type
Eveready CR 2032 ou équivalent. Respectez la polarité
de la pile. Jetez les piles usées conformément aux ins-
tructions du fabricant.
ADVARSEL!
Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering.
Udskiftning må kun ske med batteri av samme fabrikat og
type. Levér det brugte batteri tilbage til leverandøren.
VARNING!
Explosionsfara vid felaktigt batteribyte.Använd samma
batterityp eller en ekvivalent typ som rekommenderas av
apparattillverkaren. Kassera använt batteri enligt fabrikan-
tens instruktion.

COMPATIBILITÉ
ÉLECTROMAGNÉTIQUE

L’appareil est conforme aux normes indiquées dans la

Déclaration de Conformité. Il doit respecter les

2 clauses suivantes :

• L’appareil ne génère pas d’interférences parasites,

• L’appareil doit accepter toutes les interférences

qu’il reçoit, même si elles perturbent son bon

fonctionnement.

Éloignez l’appareil de tout champ électromagnétique

puissant.

• Utilisez des câbles de connexion blindés.

CONSIGNES DE SÉCURITÉ



CONSIGNES DE SÉCURITÉ

DÉCLARATION DE CONFORMITÉ

Nom du fabricant : DigiTech
Adresse du fabricant : 8760 S. Sandy Parkway

Sandy, Utah 84070, États-Unis

déclare que le produit :

Nom du produit : RPx400

Option : Toutes (nécessite un adaptateur secteur de Classe II conforme aux                       
normes EN60065, EN60742 ou équivalent).

est conforme aux normes suivantes :

Sécurité : IEC 60065-98

Compatibilité électromagnétique : EN 55013 (1990)
EN 55020 (1991)

Informations complémentaires :

Ce produit est conforme à la directive sur les appareils basse tension 72/23/EEC et à la directive sur la com-
patibilité électromagnétique 89/336/EEC comme amendé par la  directive 93/68/EEC.

Vice-President of Engineering
8760 S. Sandy Parkway
Sandy, Utah 84070, États-Unis
Date : 17 Avril 2003

Contact en Europe : Distributeur DigiTech local ou 

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah  84070, États-Unis
Tél. : (801) 566-8800
Fax : (801) 568-7583

INSTRUCTIONS À SUIVRE
LIRE LES CONSIGNES SUIVANTES :

CONSERVEZ CES CONSIGNES.

OBSERVEZ LES AVERTISSEMENTS.

RESPECTEZ TOUTES LES CONSIGNES.

N’UTILISEZ PAS CET APPAREIL À PROXIMITÉ DE
L’EAU.

NETTOYEZ L’APPAREIL UNIQUEMENT AVEC UN
CHIFFON HUMIDE.

N’OBSTRUEZ PAS LES OUÏES DE VENTILATION. INS-
TALLEZ L’APPAREIL SELON LES INSTRUCTIONS DU
FABRICANT.

ÉLOIGNEZ L’APPAREIL DE TOUTE SOURCE DE CHA-
LEUR COMME LES RADIATEURS, LES FOURS ET
MÊME LES AMPLIFICATEURS.

UTILISEZ EXCLUSIVEMENT LES FIXATIONS ET
ACCESSOIRES PRÉCONISÉS PAR LE FABRICANT.

DÉBRANCHEZ L’APPAREIL DU SECTEUR PAR TEMPS
D’ORAGE OU EN CAS DE NON UTILISATION
PROLONGÉE.

Respectez la polarité ou la mise à la terre de la prise sec-
teur. Une prise secteur polarisée présente deux bornes
dont une plus large que l’autre. Une prise avec mise à la
terre est équipée de deux fiches et d’une borne de
masse. Cette borne de masse garantit la sécurité du dis-
positif. Si la prise secteur n’est pas compatible avec votre
installation, faites remplacer la prise secteur obsolète par
un électricien.

Veillez à ne pas marcher sur le cordon secteur et à ne pas
le pincer, en particulier au niveau des prises secteur et de
l’embase secteur de l’appareil.

Utilisez uniquement supports, tables et chariots recom-
mandés par le fabricant ou vendus avec l’appareil.
Lorsque vous utilisez un chariot pour déplacer l’appareil,
prenez les précautions nécessaires pour éviter toute
blessure en cas de chute.

Faites appel à un technicien qualifié pour toute répara-
tion. L’intervention d’un technicien est nécessaire dès que
l’appareil a été endommagé (prise ou cordon secteur
endommagé, projection de liquides ou introduction d’ob-
jets étrangers à l’intérieur de l’appareil, signes de dys-
fonctionnements, chute de l’appareil).

U.K. MAINS PLUG WARNING

A molded mains plug that has been cut off from
the cord is unsafe. Discard the mains plug at a sui-
table disposal facility. NEVER UNDER ANY CIR-
CUMSTANCES SHOULD YOU INSERT A DAMA-
GED OR CUT MAINS PLUG INTO A 13 AMP
POWER SOCKET. Do not use the mains plug
without the fuse cover in place. Replacement fuse
covers can be obtained from your local retailer.
Replacement fuses are 13 amps and MUST be
ASTA approved to BS1362.



Garantie
Nous sommes très fiers des produits que nous fabriquons. C’est pourquoi DigiTech garantit ses produits.
Garantie : Les termes de la garantie et les dommages couverts dépendent du pays de distribution du produit.
Nous vous conseillons de consulter votre revendeur ou l’importateur agréé de votre pays.

REMARQUE : Les informations contenues dans ce mode d’emploi sont susceptibles d’être modifiées sans
préavis. Certaines informations relatives au produit ou au système d’exploitation peuvent donc s’avérer
inexactes au moment de l’impression de ce mode d’emploi. Les informations contenues dans cette version du
mode d’emploi annulent et remplacent toutes les précédentes.
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Introduction
Nous tenons à vous remercier d’avoir choisi le RPx400. Le RPx400 représente une véritable innovation dans
le mode du traitement pour guitares, vous offrant les outils dont vous avez besoin sur scène et les fonctions
professionnelles dont vous avez besoin en studio. Prenez le temps de lire ce mode d’emploi tout en utilisant
le processeur — il vous permettra d’exploiter au mieux toutes les fonctions du RPx400.

Éléments fournis
Avant de commencer, contrôlez que vous disposez des éléments suivants :

• Processeur à modélisation RPx400
• CD de logiciel X-Edit
• Guide d’installation du Driver USB
• Câble USB 
• Adaptateur secteur PS0913B
• Carte de garantie

Nous avons apporté le plus grand soin à la fabrication de ce RPx400. Si un élément venait à manquer,
contactez immédiatement l’usine ou votre revendeur. Remplissez également la carte de garantie nous per-
mettant de mieux vous connaître et de mieux répondre à vos besoins. En cas de problème, la garantie
couvre votre RPx400.

Face avant

1. Pédales Haut/Bas — Ces deux pédales permettent de sélectionner les Presets, d’accéder à l’accordeur ou
de bypasser le RPx400. La pédale de gauche permet de passer au Preset inférieur. Celle du milieu permet de
sélectionner le Preset supérieur.Appuyez simultanément sur les deux pédales pour bypasser le Preset.
Maintenez la pression sur les deux pédales pour passer en mode d’accordage. 1
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2. Pédale Amp A/B — Cette pédale permet de choisir l’un des deux canaux de l’ampli du Preset sélectionné.
Elle est aussi utilisée avec la pédale Haut pour accéder à la fonction Learn-A-Lick, ou aux fonctions d’enregis-
trement lorsque le RPx400 est connecté à votre ordinateur par liaison USB.

3. Boutons — Ces boutons offrent diverses fonctions selon le mode sélectionné ou lorsque le RPx400 est
connecté à votre ordinateur par liaison USB. En utilisation normale, les boutons contrôlent les paramètres
Amp Gain, Bass EQ, Mid EQ,Treble EQ et Master Level. Si le RPx400 est connecté à l’ordinateur par liaison
USB, les fonctions des boutons 2, 3, et 4 sont : Playback Mix, USB 1-2 Send Level et USB 3-4 Send Level. Lors
de l’édition ou de l’accès aux fonctions de configuration Setup, les boutons règlent les valeurs de paramètres
affichées directement au-dessus de chaque bouton, pour l’effet sélectionné. Lorsque vous utilisez la boîte à
rythme, les boutons contrôlent les paramètres Pattern,Tempo et Level. En mode accordeur, les boutons ser-
vent à sélectionner la référence d’accordage.

4. Touche Select — Cette touche vous permet de passer en mode d’addition et sélectionne les effets à édi-
ter.Appuyez plusieurs fois pour faire défiler les effets disponibles. Elle permet également de modifier la vitesse
de lecture en mode Learn-A-Lick.

5. Touche Drums — Cette touche active/désactive la boîte à rythmes intégrée. Lorsque la boîte à rythmes
est active, les Leds Drums s’allument et le Pattern de batterie sélectionné est lu en boucle.

6. Tableau — Le tableau fournit des informations sur le Preset courant et sur les fonctions d’édition des
paramètres. En mode de jeu, les Leds de gauche indiquent les effets utilisés par le Preset sélectionné. En
mode d’édition, les Leds indiquent l’effet sélectionné pour l’édition.

7. Écran — L’écran fournit les informations sur diverses fonctions, selon le mode actif. En mode de jeu,
l’écran indique le nom du Preset sélectionné et son numéro. En mode d’édition, l’écran indique le nom et la
valeur du paramètre sélectionné. En mode accordeur, l’écran indique la note jouée et si elle est trop basse,
juste ou trop haute.

8. Touche Store — Cette touche sauvegarde vos modifications dans un Preset utilisateur.

9. Pédale d’expression — La pédale d’expression permet de modifier en temps réel le paramètre d’effet qui
lui est affecté. Presque tous les paramètres peuvent être contrôlés par la pédale d’expression.

Face arrière

1. Entrée Guitar In — Utilisez ce jack pour connecter votre guitare.2
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2. Mic Level — Contrôle le gain de l’entrée micro.

3. Entrée micro — Connectez un micro pour l’enregistrement ou le mixage sur scène de sources acous-
tiques dans le RPx400. Le signal du micro peut être traité ou non par le RPx400 ; sur scène ou pour enregis-
trer. Compatible avec les micros dynamiques ou à condensateur, alimentés par fantôme.

4. Entrées ligne Left/Right — Utilisez ces entrées pour vos sources à niveau ligne pour l’enregistrement ou la
scène (mixage dans le RPx400). Les signaux ligne peuvent être traités ou non par le RPx400 ; sur scène ou
pour enregistrer.

5. Entrées CD/Monitor In — Utilisez ces entrées pour connecter la sortie casque d’un lecteur de CD ou
MP3 lorsque vous utilisez la fonction Learn-a-Lick Phrase Trainer (voir page 8 pour de plus amples renseigne-
ments sur la fonction Learn-a-Lick). Peuvent également être utilisées comme entrée d’écoute du mixage de
sortie de la carte son de votre ordinateur.

Remarque : L’utilisation de l’entrée CD/Monitor pour l’écoute en temps réel peut induire
des temps de retard, selon la vitesse de votre ordinateur.

6. Embase casque — Utilisez cette embase Jack 3,5 mm pour connecter votre casque stéréo.

7. Sorties ligne en Jack 6,35 mm — Connectez ces sorties asymétriques à votre amplificateur ou votre
console de mixage.Vous pouvez activer la fonction Speaker Compensation lorsque vous connectez cette sor-
tie à un système de sonorisation (voir page 23).

8. Sorties ligne symétriques — Connectez ces sorties à vote amplificateur de puissance, système de sonori-
sation, console de mixage offrant des entrées symétriques XLR.Vous pouvez activer la fonction Speaker
Compensation lorsque vous connectez cette sortie à un système de sonorisation (voir page 23).

9. Embase USB — Connectez cette embase USB au port USB de votre ordinateur pour enregistrer (voir
page 25, sur les fonctions USB).

ATTENTION : Installez les Drivers USB fournis sur le CD X-Edit Software avant de connec-
ter le RPx400 à votre ordinateur par le câble USB. Le RPx400 sera ainsi reconnu comme
votre source d’enregistrement pour le logiciel d’enregistrement Pro-Tracks™. Consultez le
guide d’installation du Driver USB fourni avec le RPx400.

10. Embase Footswitch — Connectez le RPxFC à 3 contacts à ce Jack. Le RPxFC vous permet de comman-
der à distance les fonctions d’enregistrement du RPx400 (voir page 35, sur les fonctions du RPxFC).

11. Embase d’adaptateur secteur — Connectez uniquement l’adaptateur secteur DigiTech PS0913B à ce Jack.

3
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Connexions
Il y a différentes façons de connecter le RPx400. Avant de connecter le RPx400, assurez-vous que votre
amplificateur et que le RPx400 sont placés hors tension. Le RPx400 ne dispose pas d’un interrupteur secteur.
Pour placer le RPx400 hors tension, déconnectez l’adaptateur secteur PS0913B de l’embase située en face
arrière.

Système avec amplificateur mono
Connectez votre guitare à l’entrée Input du RPx400. Connectez un seul câble d’instrument mono entre
la sortie Jack 6,35 mm Left Line Output du RPx400 et l’entrée instrument ou le retour d’effet de votre
amplificateur. Cette connexion convient également avec un amplificateur de puissance/enceintes actives.
Placez le réglage OUTPUT MODE sur sc off.

Système avec amplificateur stéréo
Connectez votre guitare à l’entrée Input du RPx400. Connectez deux câbles d’instrument mono entre les
sortie Jack 6,35 mm Line Outputs Left et Right du RPx400 aux entrées instrument ou retours d’effets de
chaque amplificateur. Cette connexion convient également avec un amplificateur de puissance/enceintes
actives. Placez le réglage OUTPUT MODE sur sc off.

REMARQUE : Lorsque vous utilisez un amplificateur guitare, essayez de connecter la guita-
re à l'entrée Input du RPx400 et la sortie du RPx400 au retour d’effet de l’amplificateur
pour éviter toute coloration sonore due aux réglages de tonalité de l’amplificateur.4
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Amplificateur et sonorisation
Connectez votre guitare à l’entrée Input du RPx400. Connectez un seul câble d’instrument mono entre
la sortie Jack 6,35 mm Line Output Left ou Right du RPx400 et l’entrée instrument ou le retour d’effet
de votre amplificateur ou à l’amplificateur de puissance. Connectez un câble instrument mono entre la
sortie Jack Line Output Left ou Right du RPx400 à l’entrée instrument ou au retour d’effet de votre
amplificateur ou système amplifié. Connectez les sorties XLR symétriques Left et Right aux entrées de
votre console de sonorisation et utilisez le panoramique de chaque voie à l’extrême opposé. Sélectionnez
SC XLR comme mode de sortie (voir Modes de sortie en page 23). Ceci active la simulation de haut-
parleur sur la sonorisation, mais pas sur l’amplificateur de scène. Cette connexion convient également
avec un amplificateur de puissance/enceintes actives.

Configuration d’enregistrement
Configuration d’enregistrement type utilisant les entrées ligne et micro du RPx400 et une paire de moni-
teurs connectés aux sorties XLR du RPx400. Cette configuration peut également être utilisée sur scène :
vous pouvez jouer sur un accompagnement fourni par le logiciel Pro Tracks. Consultez la section sur les
Modes de sortie en page 23 pour comprendre comment vous pouvez configurer les sorties XLR et
Jack 6,35 mm avec le simulateur de haut-parleur selon vos applications de scène ou d’enregistrement.

USB Ports
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Mise sous tension
Avant toute mise sous tension de vos équipements, réglez vos amplificateurs sur un son clair et réglez les
tonalités à plat (position 0 ou 5 sur la plupart des amplificateurs).
1. Placez le volume de l’amplificateur au minimum.
2. Connectez l’adaptateur secteur PS0913B en face arrière du processeur.
3. Reliez l’adaptateur à une prise secteur et tournez le bouton Master Level jusqu’à afficher mlevel 0.
4. Placez l’amplificateur sous tension et régler le volume sur une position d’écoute normale.
5. Augmentez progressivement le volume Master Level du RPx400 jusqu’au niveau souhaité.

Connectez l'adaptateur PS0913B 
au secteur et placez le  
Master Volume du RPx400 au 
minimum

Montez le Master Volume du 
RPx400 selon le niveau  
d'utilisation souhaité

Connectez l'adaptateur PS0913B 
à l'embase située à l'arrière du processeur

Montez le volume  
de l'amplificateur

Baissez le volume de l'amplificateur
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Les Presets
Les Presets sont des emplacements mémoires avec un nom et un numéro permettant la sauvegarde des sons
du RPx400. Le Presets sont rappelés par les pédales. Les effets actifs dans chaque Preset sont indiqués par les
Leds allumées du tableau d’effets. Le RPx400 dispose de 40 Presets utilisateur (Presets U1-U40), de
40 Presets artiste (Presets A1-A40) et de 40 Presets usine DigiTech (F1-F40). Les Presets utilisateur sont
des emplacements où vous pouvez sauvegarder vos éditions.Vous ne pouvez pas sauvegarder vos éditions
dans les Presets artiste/usine. D’usine, les 40 Presets utilisateur sont la copie des 40 Presets usine.

Mode de jeu
Lorsque vous placez le RPx400 sous tension pour la première fois, vous êtes en mode de jeu normal. Ce
mode vous permet d’accéder à tous les Presets du RPx400 par les pédales Haut/Bas. Le bouton 1 (gauche)
règle le gain du type d’amplificateur sélectionné. Le bouton 2 (deuxième en partant de la gauche) règle les
basses. Le bouton 3 (au centre) règle les médiums. Le bouton 4 (deuxième en partant de la droite) règle les
aigus. Le bouton 5 (à droite) règle le niveau général.

Bypass
Vous pouvez bypasser les Presets du RPx400 pour obtenir un son clair, non traité. Pour bypasser le RPx400,
appuyez à la fois sur les pédales HAUT et BAS. L’écran affiche alors “Bypass”.Appuyez sur l’une des
3 pédales pour quitter le Bypass et revenir au Preset sélectionné.

Accordeur
L’accordeur vous permet d'accorder ou de contrôler rapidement votre guitare. Pour activer l’accordeur,
maintenez les pédales Haut et bas enfoncées. L’écran affiche rapidement tuner. Jouez une note sur la guitare
(jouez une harmonique sur la 12ème frette, ce qui est encore meilleur). Les deux caractères à droite de
l’écran indiquent la note jouée. Les caractères de gauche indiquent si la note est trop basse ou trop haute.
Les flèches vers la gauche (<<<) indiquent que la note est trop haute et que vous devez la descendre. Les
flèches vers la droite (>>>) indiquent que la note est trop basse. Lorsque la note est juste, l’écran affiche 
--><--.

En mode accordeur, vous pouvez modifier la note de référence d’accordage. Par défaut la note est 
La = 440 Hz (affiché sous la forme A=440).Tournez le bouton 1 pour sélectionner une autre référence.Vous
pouvez sélectionner A = Ab ,A = G et A = Gb. L'écran affiche rapidement la note de référence sélectionnée.

En mode accordeur, le signal de sortie est coupé. La pédale d’expression vous permet d’obtenir le signal en
sortie lors de l’accordage. Quittez l’accordeur en appuyant sur l’une des 3 pédales.

>>><<< A

Indique que la note 
est trop basse 

Indique que 
la note est trop 

haute

Indique la  
note jouée
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Mode d’apprentissage Learn-A-Lick 
La fonction Learn-A-Lick vous permet d’enregistrer un passage musical de 10 secondes et de le lire avec une
vitesse maximale de 1/4 de sa vitesse initiale sans changer la hauteur. Cette fonction est très pratique pour
relever les notes d’un solo très rapide.
Le mode Learn-A-Lick comprend 6 fonctions :

• Stop (contrôlé par la pédale BAS)
• Rembobinage rapide (contrôlé par la pédale AMP A-B)
• Lecture (contrôlé par la pédale AMP A-B)
• Enregistrement (contrôlé par la pédale HAUT)
• Vitesse de lecture (contrôlé par la touche SELECT)
• Volume de la phrase échantillonnée (contrôlé par la pédale d’expression)

Utilisation de la fonction Learn-A-Lick
1. Connectez la sortie casque de votre lecteur de MP3/CD/cassette à l’entrée mini-Jack stéréo 3,5 mm

CD/Monitor. Réglez le niveau sur le lecteur de MP3/CD/cassettes sur le niveau d'écoute souhaité.
2. Placez-vous sur le passage que vous souhaitez enregistrer et appuyez sur la touche Pause du lecteur de

MP3/CD/cassette.
3. Maintenez les pédales UP et AMP A-B enfoncées pour accéder au mode Learn-A-Lick. L’écran affiche

rapidement : lalick.
4. Lorsque l’écran affiche READY, relâchez la touche Pause sur le lecteur et appuyez sur la pédale HAUT

(enregistrement). L’écran affiche RCRDNG et les deux caractères de droite indiquent le temps d’enregis-
trement écoulé. Lorsque vous avez terminé l’enregistrement, la phrase est placée en lecture en boucle
indiqué par “Play” à l’écran.Appuyez sur Stop ou Pause sur le lecteur de MP3/CD/cassette.

5. Utilisez la touche SELECT pour sélectionner la vitesse de lecture.Appuyez plusieurs fois sur la touche
SELECT pour modifier la vitesse de lecture jusqu’à 1/4 de la vitesse originale.Vous pouvez sélection-
ner : 1/4, 3/8, 1/2, 5/8, 3/4, 7/8 et Full (vitesse initiale).

6. Appuyez sur la pédale AMP A-B pour revenir en arrière d’une seconde à chaque fois dans la boucle.
7. La pédale d’expression contrôle le niveau de sortie de la phrase enregistrée.
8. Pour arrêter, appuyez sur la pédale DOWN (Stop).
9. Pour enregistrer un nouveau passage, appuyez à nouveau sur la pédale UP.

10. Pour quitter le mode Learn-A-Lick, maintenez les pédales UP et AMP A-B enfoncées.

REMARQUE : Le mode Learn-a-Lick n’est pas disponible lorsque le RPx400 est connecté à
l’ordinateur par liaison USB.

Fonction CD/Monitor In
La fonction CD In vous permet de connecter un lecteur de CD, MP3 ou cassette au RPx400 et de jouer sur
l’accompagnement. Pour utiliser la fonction CD In :

1. Connectez la sortie casque de votre lecteur de MP3/CD/cassette à l’entrée CD/Monitor en utilisant un
câble stéréo en mini-Jack 3,5 mm.

2. Appuyez sur la touche Play de votre lecteur de MP3/CD/cassette. Le signal de votre lecteur de
MP3/CD/cassette est affecté aux sorties gauche, droite et casque de votre RPx400.
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Boîte à rythmes
La RPx400 dispose d’une boîte à rythmes avec plusieurs Patterns de batterie échantillonnés utiles pour tra-
vailler le jeu en rythme.Appuyez sur la touche Drums pour activer la boîte à rythmes (sauf en modes Store
ou Bypass). Lorsque la boîte à rythmes est active :
Le bouton 1 permet de sélectionner le Pattern de batterie :

Le bouton 2 détermine le tempo sur une plage de 40 bpm (40 battements par minute) à 240 bpm 
(240 battements par minute).
Le bouton 3 détermine le volume du Pattern sur une plage de 1 à 99.
Appuyez à nouveau sur la touche Drums pour arrêter la lecture de la boucle de batterie.

Entrée Mic et Level
Le RPx400 dispose d’une entrée micro pouvant être utilisée pour l’enregistrement ou le mixage des chants et
des instruments acoustiques. L’entrée micro est équipée d’une alimentation fantôme pour vos micros à
condensateur professionnels. Le gain du préampli micro est contrôlé par le bouton Level. Pour régler le
niveau d'entrée, opérez comme suit :

1. Connectez un casque à la sortie correspondante.
2. Chantez ou jouez avec le volume maximum et réglez le bouton Level pour éviter toute distorsion audible.

Ceci correspond au réglage optimum du niveau de l’entrée micro.

Pour les applications utilisant l’entrée micro, consultez les chapitres Connexions et Configurations du
RPx400 de ce mode d’emploi.

ROCK 1

ROCK 2

ROCK 3

HROCK1

HROCK2

HROCK3

HROCK4

POP1

POP2

POP3

POP4

POP5

DANCE1

DANCE2

DANCE3

cntry1

cntry2

blues1

blues2

jazz

funk 1

funk 2

swing1

swing2

urban1

urban2

reggae

cha 1

cha 2

BOSSA 

mtrnom

9

Introduction



Création de Presets
Édition/création de Presets
La création de vos propres sons est très simple. Le RPx400 vous permet de créer vos propres Presets et de
modifier les Presets existants selon vos besoins. Lorsque vous créez ou éditez un son, vous devez commen-
cer par l’un des Presets User, Artist Factory ou Factory. Il n’est pas possible de commencer par un Preset
vide. Le numéro du Preset n’a pas besoin d’être le même que celui sous lequel vous souhaitez sauvegarder le
nouveau Preset.Vous pouvez utiliser n’importe quel Preset utilisateur pour la sauvegarde.

Pour éditer ou créer un Preset :
1. Utilisez les pédales Haut ou Bas pour sélectionner un Preset.
2. Une fois que vous avez trouvé un Preset que vous souhaitez éditer, appuyez sur la touche Select pour

passer en mode d’édition.
3. Utilisez la touche Select avec les Leds du tableau pour sélectionner l’effet que vous souhaitez éditer.

Appuyez à plusieurs reprises sur la touche Select pour faire défiler les effets du tableau.
4. Utilisez l’un des 5 boutons pour modifier les valeurs de paramètres.
5. Enregistrez votre Preset (voir plus bas dans cette page).

Tableau d’effets
Le tableau d'effets vous permet d’identifier les effets et paramètres sélectionnés pour l’édition. En mode
d’édition, appuyez à plusieurs reprises sur la touche Select pour passer à la rangée suivante d’effets. Les Leds
indiquent quel groupe est sélectionné. Chaque groupe d’effets offre un maximum de 5 paramètres que vous
pouvez modifier. Le bouton situé directement sous chaque colonne permet de modifier la valeur du para-
mètre de l’effet sélectionné. Lorsque vous tournez un bouton, le nom du paramètre et sa valeur ou le statut
est affiché à l’écran. Lorsque vous modifiez la valeur enregistrée d’un paramètre, la Led Store s’allume, vous
indiquant que vous devez sauvegarder les modifications. Le fait de changer de Preset ou de placer le proces-
seur hors tension avant la sauvegarde vous fait perdre vos nouveaux réglages.

Sauvegarder/Copier/Nommer un Preset
Une fois le Preset modifié, vous pouvez sauvegarder vos réglages dans l’un des 40 Presets utilisateur (Presets
U1-U40). Les étapes de la page suivante décrivent la procédure de sauvegarde des modifications d’un Preset
ou de copie d’un Preset dans un emplacement différent.

Chaque bouton règle la colonne des paramètres affichée  
directement au-dessus du bouton

Utilisez la touche Select 
pour sélectionner l'effet
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1. Appuyez une fois sur la touche Store. La Led de la touche Store clignote et le premier caractère de
l’écran clignote, indiquant que vous pouvez nommer votre nouveau Preset.

2. Utilisez le bouton 1 ou les pédales Haut/bas pour sélectionner le caractère alpha-numérique.
3. Tournez le bouton 2 vers la droite pour sélectionner le caractère suivant et vers la gauche pour sélec-

tionner le caractère précédent. Répétez l’étape 2 jusqu’à saisir le nom entier.

4. Une fois le nom affiché à l’écran, appuyez sur la touche Store. L’écran affiche alternativement le nouveau
nom et le nom du Preset qui va-t-être remplacé.

5. Sélectionnez l’emplacement du Preset utilisateur cible de votre nouveau Preset en utilisant le bouton 5
ou les pédales Haut/bas. L’écran continue d'afficher alternativement le nom du nouveau Preset et le nom
du Preset à remplacer.

6. Appuyez à nouveau sur la touche Store pour sauvegarder les modifications.

Appuyez sur la touche Select ou Drums pour annuler l’opération.

Pour copier un Preset sur une autre destination, c’est la même chose. Utilisez les pédales pour sélectionner
le Preset que vous souhaitez copier et reprenez les étapes mentionnées ci-dessus.

5. Sélectionnez le numéro de destination 
avec les pédales ou le bouton 5.

4. Appuyez à nouveau sur Store.
Le nom et le numéro du Preset 
clignotent à l'écran. 

1.  Appuyez sur Store et
les caractères clignotent

3.  Le bouton 2 sélectionne le
caractère précédent 
ou suivant à l'écran

2.  Le bouton 1 sélectionne 
les caractères alpha-
numériques
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Effets du RPx400
À propos des effets
Le RPx400 offre plusieurs amplificateurs virtuels ainsi que plusieurs pédales d’effet dans un seul boîtier pro-
grammable. L'ordre dans lequel vous insérez les pédales peut modifier radicalement le son final. Les effets du
RPx400 sont placés dans un ordre vous offrant le meilleur résultat sonore.Voici l’ordre des effets :

Définition des effets
Chaque effet du RPx400 peut être programmé selon vos goûts personnels et vos applications. La compréhen-
sion du fonctionnement de ces effets et de leurs paramètres vous aidera à obtenir le son recherché.

Pickup/Wah 
Le simulateur de micro permet d’obtenir le son d’un double-bobinage avec une guitare avec un micro à
simple bobinage ou l’inverse. Ceci vous évite de changer de guitare lors de vos concerts.

La Wah-wah est contrôlée par la pédale d’expression. En déplaçant la pédale de haut en bas et de bas en
haut, la guitare produit un son de “Wah.” La Wah-wah est activée/désactivée en appuyant sur la pédale
d’expression en avant.Voir la page 21 pour obtenir de plus amples informations sur ce commutateur.

Pickup Off/Type — Le bouton 1 sélectionne le type de micro à simuler.Vous pouvez sélectionner :
SC>HUM (donne à un simple-bobinage le son d’un Humbucker) et HUM>SC (donne à un Humbucker le son
d’un simple-bobinage) ou désactive la simulation de micro.

Wah On/Off — Le bouton 2 active/désactive l’effet de Wah.

Wah Type — Le bouton 3 sélectionne le type de Wah.Vous pouvez sélectionner : CRY (Cry Wah est un
son de Wah traditionnelle), BOUTIQ (son spécial de Wah avec un balayage plus large et un son plus
moderne) et FULRNG (Wah large bande avec balayage sur la totalité du spectre des fréquences audibles).

Wah Minimum — Le bouton 4 permet de sélectionner le point minimum atteint par la Wah en position
haute de la pédale d’expression. Plage de Ranges 1 à 99.

Wah Maximum — Le bouton 5 permet de sélectionner le point maximum atteint par la Wah en position
basse de la pédale d’expression. Plage de Ranges 1 à 99.
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Compresseur 
La compression permet d’augmenter le Sustain, d'obtenir un son compact et évite la saturation du signal
en entrée des autres effets. Elle détermine le niveau maximum du signal. Si le signal dépasse le seuil
Threshold, le taux de compression sélectionné est appliqué au signal.
Comp On/Off — Le bouton 1 active le compresseur (On) et le désactive (Off).
Attack — Le bouton 2 détermine le temps mis par la compression pour traiter le signal lorsqu’il franchit
le seuil Threshold. Plage de valeurs : fast, medium et slow.
Ratio — Le bouton 3 détermine le rapport niveau de sortie par rapport au niveau d’entrée une fois le
seuil Threshold franchi. Par exemple, un taux de 4 pour 1 signifie que lorsque le signal d’entrée dépasse le
seuil Threshold de 4 dB, le niveau de sortie n’augmente que de 1 dB. Plage de : 1.2-1 (1.2 à 1), 1.5-1 (1.5 à
1), 1.8-1 (1.8 à 1), 2.0-1 (2 à 1), 2.5-1 (2.5 à 1), 3.0-1 (3 à 1), 4.0-1 (4 à), 5.0-1 (5 à 1), 8.0-1 (8 à 1), 10-1
(10 à 1), 20-1 (20 à 1), et 00-1 (infini à 1).
Threshold — Le bouton 4 détermine le niveau de seuil à partir duquel le signal est compressé. Plage de 1
à 99.
Gain — Le bouton 5 détermine le gain de sortie après compression. Plage de 0 à 6 (dB).

Modélisation d’amplificateur/enceinte
La modélisation d’amplificateur est une technologie qui applique le son d’un amplificateur Vintage ou
moderne à votre guitare. La modélisation d’amplificateur du RPx400 permet également la simulation de
guitare acoustique. La section Amp Modeling offre deux canaux A et B. Chaque canal peut être program-
mé séparément avec des réglages individuels (Amp Gain,Amp Level, Cabinet Type, Mic Position et EQ).
Ceci vous permet de passer d’un son clair à un son saturé tout en conservant tout les autres effets.Vous
pouvez changer de canal en appuyant sur la pédale Amp A/B.

La modélisation d’enceinte Cabinet Modeling émule divers types d’enceintes reprises par micro.Vous pou-
vez choisir parmi 6 types d’enceintes et 4 positions de micro par enceinte.
Amp Channel — Le bouton 1 sélectionne le canal A ou B.Vous pouvez également utiliser la pédale A/B
pour sélectionner le canal de l’ampli lors de l’édition.
Amp Type — Le bouton 2 sélectionne les modèles d’amplificateurs ou le simulateur acoustique :

Marshall® est une marque déposée de Marshall Amplification Plc. Vox® est une marque déposée de Korg UK. Fender, Matchless et Mesa Boogie sont des

marques déposées de leurs propriétaires respectifs et ne sont pas associées à DigiTech.

Amp Gain — Le bouton 3 détermine le gain (distorsion) du modèle d’amplificateur sélectionné (pas dis-
ponible pour la simulation acoustique). Le paramètre de gain est réglable de 0 à 99.
Amp Level — Le bouton 4 détermine le niveau (volume) du modèle d’amplificateur sélectionné. Le para-
mètre Level est réglable de 1 à 99.
Cabinet-Mic — Le bouton 5 sélectionne le type d’enceinte et la position du micro par rapport à l’encein-
te (voir en page suivante).

DIRECT — Désactive la modélisation 
BLKFAC — Twin Reverb Fender de 1965
BOUTIQ — Basé sur un DC30 Matchless 
RECTIF — Basé sur un Dual Rectifier Mesa 
HOTROD — Basé sur un Mark II C Mesa Boogie 
tweeD — Basé sur un ‘57 Tweed Deluxe Fender
CLEAN1 — Basé sur un AC30 Top Boost Vox 

CLEAN2 — Combo à lampes à son clair
STACK — Basé sur un JCM900 Marshall 
CRUNCH — Combo à lampes à son saturé
HIGAIN — Basé sur un Johnson JM150 High
Gain
FUZZ — Distorsion Fuzz Vintage
ACOUST — Guitare acoustique
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Voici comment sont placés les micros par rapport au réglage Mic 1 à Mic 4 :

EQ
L’égalisation est un outil très utile pour modeler la réponse sonore de votre signal de guitare. L’effet EQ
du RPx400 est identique aux boutons de tonalité sur un amplificateur. Les trois réglages d’égalisation sont
variables de -12 dB à +12 dB.
EQ On/Off — Le bouton 1 active (On) et désactive (OF) l’égalisation.
Bass — Le bouton 2 détermine le réglage des graves.
Mid — Le bouton 3 sélectionne la fréquence d’accentuation des médiums. Plage de 500 Hz à 3 000 Hz.
Mid Level — Le bouton 4 détermine le niveau des médiums.
Treble — Le bouton 5 détermine le réglage des aigus.

Noise Gate
Le Noise Gate élimine les bruits de fond de souffle ou de ronflement lorsque vous ne jouez pas. Le Noise
Gate peut également être utilisé pour créer une montée automatique du volume. Le RPx400 offre deux
types de Noise Gates : Silencer™ et Pluck. Le Silencer™ fonctionne comme un Noise Gate standard. Le
Noise Gate Pluck se ferme après chaque notre (selon le réglage Sensitivity). Ceci permet d’obtenir un
effet de montée automatique du volume note par note.

no cab — Cabinet Off
1X12 1 — 1 x 12 Mic 1
1X12 2 — 1 x 12 Mic 2
1X12 3 — 1 x 12 Mic 3
1X12 4 — 1 x 12 Mic 4

2X12 o 1 — 2 x 12 arrière ouvert Mic 1
2X12 o 2 — 2 x 12 arrière ouvert Mic 2
2X12 o 3 — 2 x 12 arrière ouvert Mic 3
2X12 o 4 — 2 x 12 arrière ouvert Mic 4

2X12 c 1 — 2 x 12 arrière clos Mic 1
2X12 c 2 — 2 x 12 arrière clos  Mic 2
2X12 c 3 — 2 x 12 arrière clos  Mic 3
2X12 c 4 — 2 x 12 arrière clos Mic 4

4X12 V 1 — 4 x 12 Vintage Mic 1
4X12 V 2 — 4 x 12 Vintage Mic 2
4X12 V 3 — 4 x 12 Vintage Mic 3
4X12 V 4 — 4 x 12 Vintage Mic 4

4X12 B 1 — 4 x 12 British Mic 1
4X12 B 2 — 4 x 12 British Mic 2
4X12 B 3 — 4 x 12 British Mic 3
4X12 B 4 — 4 x 12 British Mic 4

4X12 G 1 — 4 x 12 Green Mic 1
4X12 G 2 — 4 x 12 Green Mic 2
4X12 G 3 — 4 x 12 Green Mic 3
4X12 G 4 — 4 x 12 Green Mic 4
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Gate On/Off — Le bouton 1 active (On) ou désactive (OF) le Noise Gate.
Gate Type — Le bouton 2 sélectionne le Noise Gate Silencer ™ (silncr ) ou Pluck (pluckd).
Gate Attack — Le bouton 3 règle la durée mise par le Noise Gate pour s’ouvrir une fois que le signal
dépasse le seuil Threshold avant que le signal devienne audible. Plage de 0 (signal immédiat) à 9 (effet de
montée automatique de volume).
Gate Threshold — Le bouton 4 détermine le niveau du signal devant déclencher le Noise Gate. Le para-
mètre Threshold varie sur une plage de 1 (ouverture facile) à 40 (nécessite un signal puissant pour ouvrir
le Noise Gate).
Pluck Sensitivity — Le bouton 5 contrôle le point à partir duquel le Noise Gate se redéclenche lorsque
vous utilisez le Noise Gate Pluck. Ce paramètre est uniquement disponible lorsque Pluck est sélectionné.
Plage de 1 (nécessite un signal puissant pour redéclencher) à 99 (redéclenche avec des signaux faibles).

Effets Chorus/Mod
Les effets de la rangée Chorus/Mod du RPx400 offrent un module multifonction vous permettant de
sélectionner les effets de Chorus, Flanger,Triggered Flanger, Phaser,Triggered Phaser,Tremolo, Panner,
Vibrato, Rotary Speaker,YaYa™,AutoYa™, SynthTalk™, Envelope Filter (Wah automatique), Detune, Pitch
Shift et Whammy™. Lorsque la rangée des effets est sélectionnée, le bouton 1 active les effets du module
(EFFECT OF) et sélectionne le type d’effet de modulation.Après avoir sélectionné le type d’effet du
module, les boutons 2-5 servent à régler les divers paramètres de chaque effet.Voici une description des
effets et de leurs paramètres :

Chorus
Le Chorus ajoute un délai très rapide à votre signal. Le signal retardé est modulé en phase et hors-
phase, puis il est re-mélangé avec le signal original pour créer un son plus épais.
Paramètre 1 — Le bouton 2 règle la vitesse de la modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de la modulation. Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le volume du Chorus. Plage de 1 à 99.
Le bouton 4 n’a pas de fonction lorsque le Chorus est sélectionné.

Flanger
Le Flanger reprend le principe du Chorus mais utilise un temps de retard plus court et ajoute une
réinjection (répétitions) à la modulation retardée. Il en résulte un mouvement de balayage extrême.
Paramètre 1 — Le bouton 2 règle  la vitesse de modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle  l’intensité (profondeur) de la modulation. Plage de 1 à 99.
Paramètre 3 — Le bouton 4  règle la réinjection (répétitions) ajoutée au Flanger. Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

Triggered Flanger (Flanger déclenché)
Un Flanger déclenché offre le même son qu’un Flanger classique mais vous permet de choisir le point
de début du balayage.Avec un Flanger classique, l’oscillateur basse fréquence (LFO) balaaie en perma-
nence. Ceci signifie que lorsque vous commencez à jouer, il se peut que le Flanger soit en fin de
balayage ou sur tout autre point du balayage.Avec le Flanger déclenché, à chaque fois que le niveau du
signal dépasse le réglage Sensitivity, le Flanger commence au point de balayage que vous sélectionnez
par le réglage LFO Start.
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Paramètre 1 — Le bouton 2 règle la vitesse de la modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle le niveau du signal (Sensitivity) devant déclencher le Flanger. Plage
de 1 (nécessitant un signal important pour le déclenchement) à 99 (déclenchement sur signaux
faibles).
Paramètre 3 — Le bouton 4 sélectionne le point de début du balayage du Flanger (début de LFO).
Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

Phaser
Le Phaser sépare le signal en deux canaux — un déphasé et l’autre normal. Le signal déphasé et alors
mélangé au signal original.Avec la modulation du déphasage, certaines fréquences sont annulées, ce qui
donne cet effet de mouvement au son.
Paramètre 1 — Le bouton 2 règle la vitesse de la modulation du déphasage. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de la modulation. Plage de 1 à 99.
Paramètre 3 — Le bouton 4 règle le niveau du signal traité réinjecté en entrée de l’effet de Phaser.
Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

Triggered Phaser (Phaser déclenché)
Le Phaser déclenché offre le même son qu’un Phaser classique mais vous permet de choisir le point
de début du balayage.Avec un Phaser classique, l’oscillateur basse fréquence (LFO) déphase en perma-
nence le signal. Ceci signifie que lorsque vous commencez à jouer, il se peut que le Phaser soit en fin
de balayage ou sur tout autre point du déphasage.Avec le Phaser déclenché, à chaque fois que le
niveau du signal dépasse le réglage Sensitivity, le Phaser commence au point de déphasage que vous
sélectionnez par le réglage LFO Start.
Paramètre 1 — Le bouton 2 règle la vitesse du déphasage. Plage de 1 à 99.
Paramètre 2 — Le bouton 3  règle le niveau du signal (sensibilité) devant déclencher le Phaser. Plage
de 1 (nécessitant un signal important pour le déclenchement) à 99 (déclenchement sur signaux
faibles).
Paramètre 3 — Le bouton 4 sélectionne le point de début de balayage du Phaser (LFO Start). Plage
de 0 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

Tremolo
L’effet de Tremolo module le volume du signal avec une vitesse constante.
Paramètre 1 — Le bouton 2 règle la vitesse de variation du volume. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle  l’intensité (profondeur) de modulation du volume. Plage de 0 à 99.

Les boutons 4 et 5 sont inopérants lorsque l’effet Tremolo est sélectionné.
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Panner
Le Panner automatique module le son de gauche à droite avec une vitesse constante.
Paramètre 1 — Le bouton 2 règle la vitesse de déplacement du signal. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet. Plage de 0 à 99.
Les boutons 4 et 5 sont inopérants lorsque l’effet Panner est sélectionné.

Vibrato
Le Vibrato module la hauteur du signal d’entrée avec une vitesse constante.
Paramètre 1 — Le bouton 2 règle la vitesse de modulation de la hauteur. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet. Plage de 1 à 99.
Les boutons 4 et 5 sont inopérants lorsque l’effet Vibrato est sélectionné.

Rotary Speaker
L’effet Rotary Speaker offre une simulation de cabine Leslie comprenant un Tweeter à compression
tournant et un Woofer, également tournant. La rotation de ces deux haut-parleurs produit un son qui
se déplace dans l’espace, avec une légère variation de la hauteur due à la vitesse de déplacement du
son par rapport à l’auditeur.
Paramètre 1 — Le bouton 2 règle la vitesse de rotation des haut-parleurs. Plage de 0 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet. Plage de 0 à 99.
Paramètre 3 — Le bouton 4 contrôle l'effet Doppler sous la forme d’un ratio entre le Tweeter et le
Woofer. Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

YaYa™
L’effet YaYa™ est exclusif à DigiTech. L’effet YaYa™ est contrôlé par la pédale d’expression et associe
les caractéristiques d’une Wah et d’un Flanger, offrant un effet unique de type Talk Box. Lors du dépla-
cement de la pédale d’expression, la guitare semble dire “Yah”. L’effet YaYa™ doit être connecté à la
pédale d’expression pour fonctionner (voir page 18).
Paramètre 1 — Le bouton 2 règle la pédale.
Paramètre 2 — Le bouton 3 règle l’intensité (profondeur) de l’effet YaYa™. Plage de 0 à 99.
Paramètre 3 — Le bouton 4 règle le son rocailleux de l’effet YaYa™. Plage de 1 à 50.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).

AutoYa™
Comme l’effet YaYa™, l’effet AutoYa™ associe les caractéristiques d’une Wah et d’un Flanger, ce qui
permet d'obtenir des sons de voyelles, comme si la guitare disait “Yah”. L’effet AutoYa™ permet d’ob-
tenir cet effet automatiquement en modulant le son à vitesse constante.
Paramètre 1 — Le bouton 2 règle la vitesse de modulation. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle l’intensité de l’effet.AutoYa™. Plage de 1 à 99.
Paramètre 3 — Le bouton 4 règle le son rocailleux de l’effet AutoYa™. Plage de 1 à 50.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).
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SynthTalk™
L’effet SynthTalk™ est un autre effet exclusif à DigiTech. La guitare semble parler en fonction de la
force de l’attaque sur les cordes.
Paramètre 1 — Le bouton 2 règle l’attaque de la voix synthétisée. Plage de 1 à 99.
Paramètre 2 — Le bouton 3 règle le rétablissement de la voix synthétisée. Plage de 1 à 99.
Paramètre 3 — Le bouton 4 modifie les caractéristiques des voix synthétisées. Plage de 0 à oo (infini).
Mod Level — Le bouton 5 règle la sensibilité ou le niveau du signal d’entrée requis pour déclencher
l’effet SynthTalk™. Plage de 1 à 99.

Envelope Filter
L’effet Envelope Filter est une Wha automatique qui modifie votre son en fonction de l’attaque sur les
cordes.
Paramètre 1 — Le bouton 2 règle le niveau du balayage de la Wah une fois la Wah déclenchée. Plage
de 1 à 99.
Paramètre 2 — Le bouton 3 règle règle la sensibilité ou le niveau du signal d’entrée requis pour
déclencher l’effet Wah. Plage de 1 à 99.
Mod Level — Le bouton 5 contrôle le mélange signal traité/non traité. Plage de 0 (non traité) à 99
(entièrement traité).
Le bouton 4 est inopérant lorsque l’effet Envelope Filter est sélectionné.

Detune
L’effet Detuner désaccorde légèrement le signal et le mélange avec le signal d’entrée. Il en résulte un
effet comme si deux guitares jouaient ensemble.
Paramètre 1 — Le bouton 2 règle la différence de hauteur appliquée au signal. Plage de -18 à 18.
Mod Level — Le bouton 5 contrôle le volume de la note désaccordée. Plage de 0 à 99.
Les boutons 3 et 4 sont inopérants lorsque l’effet Detune est sélectionné.

Pitch Shift
L’effet Pitch Shifter transpose la note d’entrée. La note transposée est alors mélangée à la note initia-
le, créant une harmonisation de la guitare.
Paramètre 1 — Le bouton 2 sélectionne l’intervalle de transposition. Plage de -12 (12 demi-tons en
dessous de la note de départ) à 24 (24 demi-tons au-dessus de la note de départ).
Mod Level — Le bouton 5 contrôle le volume de la note transposée. Plage de 0 à 99.
Les boutons 3 et 4 sont inopérants lorsque l’effet Pitch Shift est sélectionné.
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Whammy™
L’effet Whammy™ utilise la pédale d’expression pour modifier progressivement la hauteur du signal
d’entrée, ou pour ajouter une harmonie glissée au signal initial. La hauteur de la note glisse progressi-
vement vers le haut ou vers le bas avec le mouvement de la pédale. Lorsque l’effet Whammy™ est
sélectionné, il est automatiquement placé avant l’étage Amp Modeling comme indiqué par le synop-
tique (en fin de la section sur les effets). L’effet Whammy™ doit être lié à la pédale d’expression pour
fonctionner (voir page 18, sur l’utilisation de la pédale d’expression).
Paramètre 1 — Le bouton 2 sélectionne l’intervalle et la direction de la transposition. Les choix sont
les suivants :

Mod Level — Le bouton 5 règle le volume de la Whammy™. Plage de 0 à 99.
Le bouton 4 est inopérant lorsque la Whammy™ est sélectionnée.

Delay 
Le Delay est un effet de répétition retardée du signal d’entrée. La répétition peut être unique, multiple ou
infinie (ce qui coupe l’entrée du délai et vous permet de jouer sur un passage de la boucle de délai).
Delay On/Off — Le bouton 1 active (On) et désactive (OF) le délai.
Delay Type — Le bouton 2 sélectionne l’un des 3 types de délai : DIGTAL (délai numérique), ANALOG
(analogique), P PONG (Ping Pong).
Delay Time — Le bouton 3 règle le temps de retard. Plage de 10 MS à 990 MS (10 à 990 ms par pas de
10 ms) et 1 SEC à 2 SEC (1 seconde à 2 secondes par pas de 100 ms).
Feedback — Le bouton 4 règle le nombre de répétitions. Plage de 1 à 99 et rhold (répétition infinie).
Delay Level — Le bouton 5 règle le volume du signal du délai. Plage de 0 à 99.

Reverb 
L’effet Reverb procure à l’auditeur une sensation d’environnement acoustique réglable.Vous pouvez choi-
sir l’environnement étroit d’une petite pièce ou un stade de Football.
Reverb Type — Le bouton 1 sélectionne le type de réverbération ou d’environnement acoustique. Le
RPx400 offre un choix de dix environnements différents :

REVERBOF = Reverb inactive
STUDIO = Studio
ROOM = Pièce bois
CLUB = Piano bar

PLATE = Plaque  
HALL = Hall
AMPTHE = Amphithéâtre
CHURCH = Église

GARAGE = Parking
ARENA = Stade
SPRING = Ressorts

Whammy (pas de signal non traité)
1OCTUP (1 octave au-dessus) 
2OCTUP (2 octaves au-dessus)
2NDDWN (1 seconde inférieure)
REV2ND (1 seconde inf., pédale inversée)
4THDWN (Quarte inférieure)
1OCTDN (1 octave inférieure)
2OCTDN (2 octaves inférieures)
DIVBOM (Dive Bomb)

Harmonisation (avec signal non traité)
M3>MA3 (Tierce majeure à tierce majeure)
2NDMA3 (Seconde inf. à tierce majeure sup.)
3RD4TH (Tierce inf. à quarte sup.)
4TH5TH (Quarte sup. à quinte sup.)
5THOCT (Quinte sup. à une octave sup.)
HOCTUP (1 octave supérieure)
HOCTDN (1 octave inférieure)
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PreDelay — Le bouton 2 règle le temps mis par le son initial pour atteindre la première surface réfléchis-
sante de l’environnement simulé. Plage de 0 à 15.
Decay — Le bouton 3 règle la durée de la réverbération. Plage de 1 à 99.
Damping — Le bouton 4 contrôle le niveau du signal absorbé par l’environnement simulé. Plage de 0 à
99.
Reverb Level — Le bouton 5 règle le volume de la réverbération. Plage de 0 à 99.

Pédale d’expression
La pédale d’expression du RPx400 peut être assignée pour contrôler au pied le volume, la Whammy™, le
Ya Ya™ du RPx400, ainsi qu’à peu près tous ses paramètres en temps réel. Lorsque un paramètre est assi-
gné à la pédale d’expression, une valeur programmable minimum et maximum est également assignable. La
procédure d’assignation d’un paramètre à la pédale d’expression est la suivante :
1. Appuyez sur la touche Select jusqu’à sélectionner la rangée Expression (indiqué par la Led allumée

dans la rangée Expression).
2. Tournez le bouton 1 jusqu’à ce que le mot PEDAL s’affiche à l’écran.
3. Tournez le bouton 2 jusqu’à ce que le paramètre souhaité s’affiche à l’écran.
4. Tournez le bouton 3 pour sélectionner la valeur minimum atteinte par le paramètre lorsque la pédale

d’expression est en position haute (pas possible lorsque le volume est le paramètre affecté).
5. Tournez le bouton 4 pour sélectionner la valeur maximum atteinte par le paramètre lorsque la pédale

d’expression est en position basse (pas possible lorsque le volume est le paramètre affecté).
6. Sauvegardez l’affectation de la pédale d’expression avec votre Preset (voir page 9).

Les paramètres contrôlables par la pédale d’expression sont les suivants :
A GAIN (Amp Gain) — La pédale d’expression contrôle le gain de l’ampli (distorsion) du type d’ampli

sélectionné.
AMPLVL (Amp Level) — La pédale d’expression contrôle le volume du type d’ampli sélectionné.
Paramètres des effets de modulation 

Effet actif Paramètres disponibles 
Chorus Speed (vitesse), Depth (profondeur)
Flanger Speed (vitesse), Depth (profondeur), Regen (répétitions)
Triggered Flanger Speed (vitesse), SENSTV (sensibilité), LFOSTR (début LFO)
Phaser Speed (vitesse), Depth (profondeur), Regen ( répétitions)
Triggered Phaser Speed (vitesse), SENSTV (sensibilité), LFOSTR (début LFO)
Tremolo SPEED (vitesse), DEPTH (profondeur)
Panner SPEED (vitesse), DEPTH (profondeur)
Vibrato SPEED (vitesse), DEPTH (profondeur)
Rotary Speaker SPEED (vitesse), DEPTH (profondeur), DOPLER (Doppler)
YaYa™ YAYA (pédale), DEPTH (profondeur), RANGE (plage)
Auto Ya™ SPEED (vitesse), DEPTH (profondeur), RANGE (plage)
SynthTalk ATTACK (attaque), RELEAS (rétablissement), VOX (Vox), SENSTV (sensibilité)
Envelope Filter range (taux), SENSTV (sensibilité)
Detune AMOUNT (taux)
Pitch Shift AMOUNT (taux)
Whammy™ WHAMMY (pédale), AMOUNT (taux)

YAYA  (YaYa™) — La pédale d’expression agit comme un effet de Ya Ya™ lorsque YaYa™ est actif.
WHAMMY (Whammy™) — La pédale d’expression sert de Whammy™ lorsque Whammy™ est actif.
FXLeVL (Niveau d’effet) — La pédale d’expression contrôle le niveau de Mix de l’effet de modulation

sélectionné.
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FBACK (Feedback) — La pédale d’expression contrôle le nombre de répétitions du délai.
DLYLVL (Delay Level) — La pédale d’expression contrôle le niveau de Mix du type de délai sélectionné.
DECAY (Decay) — La pédale d’expression contrôle la longueur du temps de chute de la réverbération.
REVLVL (Reverb Level) — La pédale d’expression contrôle le niveau de Mix de la réverbération.
VOLPRE (Volume Pre) — La pédale d’expression contrôle le volume après l'étage Amp Modeling et avant

les effets.
VOLPST (Volume Post) — La pédale d’expression contrôle le volume en fin des effets.

Commutateur virtuel V-Switch
La pédale d’expression du RPx400 dispose du commutateur virtuel DigiTech V-Switch. Le V-Switch per-
met de modifier l’affectation de la pédale d’expression à la volée.Appuyez avec l’avant du pied sur la
pédale d’expression pour activer le V-Switch. La fonction de la pédale d’expression passe du paramètre
assigné à la fonction de Wah. La sensibilité ou la pression nécessaire au déclenchement du V-Switch est
réglable (selon vos goûts ou le poids de votre pied).Voir page 36, sur la procédure de réglage de la
sensibilité du V-Switch.

LFO
Le RPx400 dispose de deux oscillateurs basse fréquence assignables (LFO TR et LFO SQ) que vous
pouvez assigner à n’importe quel paramètre pouvant être assigné à la pédale d’expression. Le LFO fait
varier automatiquement la valeur du paramètre assigné avec une vitesse constante.Vous pouvez sélec-
tionner quelles valeurs maximum et minimum chaque LFO peut atteindre. Par exemple, si vous assi-
gnez le paramètre Amp Gain au LFO TR et si la valeur minimum est réglée sur 1 et la valeur maxi-
mum est réglée sur 99, le RPx400 passe automatiquement d’un son clair à un son saturé. Les vitesses
de LFO peuvent également être assignées. Dans l’exemple précédent, la vitesse du LFO détermine le
temps mis par le LFO pour passer du son clair au son saturé. LFO TR oscille en utilisant une forme
d’onde triangulaire. Le LFO SQ utilise une onde carrée.Voici la procédure d’assignation des LFO du
RPx400 :
1. Appuyez sur la touche Select jusqu’à ce que la rangée Expression soit sélectionnée (Led allumée

dans la rangée Expression).
2. Tournez le bouton 1 pour sélectionner si vous souhaitez assigner LFO TR (LFO TR) ou LFO SQ

(LFO SQ).
3. Tournez le bouton 2 jusqu’à ce que le paramètre souhaité s’affiche.
4. Tournez le bouton 3 pour sélectionner la valeur minimum du paramètre sélectionné lors du chan-

gement inférieur du LFO (pas disponible lorsque le volume est le paramètre assigné).
5. Tournez le bouton 4 pour sélectionner la valeur maximum du paramètre lors du changement supé-

rieur du LFO (pas disponible lorsque le volume est le paramètre assigné).
6. Tournez le bouton 5 pour sélectionner la vitesse du LFO entre les valeurs minimum et maximum.

Plage de 1 à 99.
7. Sauvegardez les affectations de LFO avec votre Preset.Voir en page 10 pour obtenir de plus amples

renseignements sur les procédures de sauvegarde.
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Configurations du RPx400 
Introduction aux configurations 
Le RPx400 est équipé de quatre entrées et de quatre sorties que vous pouvez configurer de différentes
façons pour la scène ou l’enregistrement. Ces configurations sont sélectionnées dans la rangée
DRUMS/SETUP du tableau à l’aide des cinq boutons d’édition.Vous pouvez choisir si les entrées Mic ou
Line sont routées aux effets du RPx400, quelles sorties sont traitées par l’effet de compensation de haut-par-
leur, et à quelle paire de sorties le traitement du micro, de l’entrée ligne, ou de l’entrée guitare doit être
affecté. Les touches USB 1-2 Source et USB 3-4 Source servent à configurer comment toutes les
entrées, le traitement guitare et la boîte à rythme sont routés par liaison USB à l’ordinateur pour l’enregis-
trement.

Configurations Mic/Line
Les configurations Mic et Line sont prévues principalement pour la scène. Le RPx400 sert de mixage pour
les sources micro et ligne. Ceci peut vous éviter d’avoir à utiliser un mélangeur, lorsque les sorties du
RPx400 sont connectées directement à des enceintes amplifiées. Ces entrées peuvent être routées avec
ou sans traitement par les effets du RPx400, puis être mélangées directement aux sorties Jack 6,35 mm
et XLR du RPx400.

Les entrées Mic et Line offrent quatre réglages que vous pouvez sélectionner séparément par les boutons
Mic et Line de la rangée DRUMS/SETUP du tableau d’effets. Les configurations sont les suivantes :

MICOFF / LINOFF — Entrées Mic et Line désactivées.
MICDRY / LINDRY — Entrées routées directement aux sorties du RPx400, sans effets.
MICRVB / LINRVB — Entrées affectées aux effets de délai et de réverbération du Preset courant.
MICFX / LINEFX — Entrées affectées à tous les effets du Preset courant.

Routage de l’entrée micro 

Routage de l’entrée ligne

Line gauche

Line droite

linefx linrvb lindry

+
Pickup

Sim Wah Comp
Amp/

Cabinet
EQ

Noise
Gate

Mod/
Chorus Delay Reverb

+

+

+

+

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

micfx micrvb micdry
Entrée Mic

Pickup
Sim Wah Comp

Amp/
Cabinet

EQ

Noise
Gate

Mod/
Chorus Delay Reverb

+

+

+

+

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite
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Compensation de haut-parleur et modes de sortie
Le RPx400 dispose de sorties en Jacks 6,35 mm et en XLR. Ces connecteurs vous permettent de
connecter le RPx400 simultanément à un système d’amplificateur/enceintes sur scène par les sorties
Jacks 6,35 mm et à votre sonorisation par les XLR. Le RPx400 est équipé d’un circuit de compensation
de haut-parleur (Speaker Compensation) que vous pouvez activer indépendamment sur chaque sortie,
selon vos besoins. Les six modes de sortie du RPx400 sont les suivants :

SCOFF — Toutes les sources d’entrée (guitare, micro, ligne, rythmes et lecteur) sont routées aux deux
paires de sorties. La compensation de haut-parleur Speaker Compensation est désactivée.

SCXLR — Toutes les sources d’entrée sont routées aux deux paires de sorties. La compensation de haut-
parleur Speaker Compensation est activée uniquement sur les sorties XLR.

SC 1/4 — Toutes les sources d’entrée sont routées aux deux paires de sorties. La compensation de
haut-parleur Speaker Compensation est activée uniquement sur les sorties Jack 6,35 mm.

SC ALL — Le traitement stéréo guitare, le micro et l’entrée ligne sont routées aux deux paires. La com-
pensation de haut-parleur Speaker Compensation est activée uniquement sur les sorties Jack
6,35 mm et XLR.

micrvb micdry

linrvb lindry

DRUMS

micfx

linefx

Pickup
Sim Wah Comp

Amp/
Cabinet

EQ

Noise
Gate

Mod/
Chorus Delay Reverb

+

+

+

+

+

+

SC+

SC = Module de compensation de haut-parleur

Entrée Mic

Entrée Guitare

Line gauche

Line droite

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

micrvb micdry

linrvb lindry

DRUMS

micfx

linefx

SC = Module de compensation de haut-parleur

Pickup
Sim Wah Comp

Amp/
Cabinet

EQ

Noise
Gate

Mod/
Chorus Delay Reverb

+

+

+

+

+

+

SC

SC

+
Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Entrée Mic

Entrée Guitare

Line gauche

Line droite

micrvb micdry
Entrée Mic

Entrée Guitare

Line gauche

Line droite

linrvb lindry

Pickup
Sim Wah Comp

DRUMS

Amp/
Cabinet

EQ

Noise
Gate

Mod/
Chorus Delay Reverb

SC

SC

+

+

+

+SC

+

+

micfx

linefx

+

= Module de compensation de haut-parleur

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

23

RPx400 — Configurations



Les modes de sortie SPLIT1 et SPLIT2 sont conçus pour isoler le traitement de la guitare de celui des
entrées micro, ligne, rythmes et du lecteur audio sur scène. Le mode de sortie SPLIT1 affecte le signal
de la guitare aux sorties Jack 6,35 mm, alors que les signaux des entrées micro, ligne, rythmes et de l’or-
dinateur sont affectés aux sorties XLR. SPLIT2 est identique à SPLIT1, sauf que le signal de la guitare
avec compensation haut-parleur est aussi affecté aux sorties XLR.

SPLIT1 — Le traitement stéréo de la guitare est affecté aux sorties Jack 6,35 mm sans compensation. Le
son de l’ordinateur, de l’entrée micro et ligne est affecté aux sorties XLR.

SPLIT2 — Le traitement stéréo de la guitare est affecté aux sorties Jack 6,35 mm sans compensation. Le
traitement stéréo de la guitare, le son de l’ordinateur, de l’entrée micro et ligne est affecté
aux sorties XLR avec compensation.

REMARQUE : La compensation de haut-parleur peut affecter les signaux des entrés Mic et
Line selon le mode de sortie sélectionné.

micrvb micdry

linrvb lindry

DRUMS

micfx

linefx

SC = Module de compensation de haut-parleur

Pickup
Sim Wah Comp
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EQ
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+

+

+
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SC

SC

Entrée Mic

Entrée Guitare

Line gauche

Line droite

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite

Entrée Mic

Entrée Guitare
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Line droite

micrvb micdry

linrvb lindry

DRUMS

micfx

linefx

SC = Module de compensation de haut-parleur
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Gate
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+

+

+

+
+

Sortie XLR gauche
Sortie XLR droite

Sortie Jack gauche
Sortie Jack droite
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Le RPx400 en enregistrement
Introduction à l’enregistrement
La connexion USB du RPx400 offre simultanément 4 canaux audio vers l’ordinateur et 2 canaux de lecture
depuis l’ordinateur. L’enregistrement n’a jamais été plus simple, grâce à l’environnement “main-libre” offert par
l’utilisation du RPx400 et du logiciel Pro Tracks. L’utilisation des pédales du RPx400 et de Pro Tracks vous
permet d’armer, d’enregistrer, de lire et d’effacer automatiquement les pistes à la volée, sans avoir à quitter la
guitare. Des configurations d’enregistrements multiples peuvent être sélectionnées pour optimiser vos
besoins d’enregistrement. Ces configurations sont accessibles sur le RPx400, par la rangée DRUMS/SETUP
du tableau d’effets.

Pour enregistrer, vous devez tout d’abord installer les Drivers USB et Pro Tracks sur votre ordinateur tour-
nant sous Windows. Les Drivers USB se trouvent sur le CD X-Edit fourni avec le RPx400. Le CD Pro Tracks
est dans la boîte Pro Tracks. Lisez le mode d’emploi de Pro Tracks pour vous assurer que votre ordinateur
offre les caractéristiques nécessaires avant l’installation. Une fois l’installation achevée, le RPx400 peut alors
contrôler Pro Tracks et ses fonctions d’enregistrement.

Installation des Drivers USB du RPx400
Les Drivers USB du RPx400 doivent être installés avant d’utiliser le logiciel de bibliothèque et d’édition
X-Edit ou Pro Tracks. Ces Drivers se trouvent sur le CD X-Edit fourni avec le RPx400. Pour installer 
X-Edit et les Drivers USB, opérez comme suit :

Windows XP
1. Lancez l’ordinateur.
2. Insérez le CD X-Edit dans votre lecteur de CD. Le menu d’installation devrait s’afficher automati-

quement (dans le cas contraire, cliquez sur Démarrer>Lancer, cliquez sur Rechercher et
double-cliquez sur instmenu.exe sur le CD X-Edit).

3. Vous devez tout d’abord installer les Drivers USB correspondants pour utiliser la liaison USB avec
X-Edit et Pro Tracks. Cette procédure sera la même lorsque vous mettrez à jour les Drivers du
RPx400, dans l’avenir. Connectez le câble USB fourni entre l’ordinateur et le RPx400. Plusieurs
messages s’affichent indiquant que votre ordinateur a trouvé un périphérique USB. Il y a plusieurs
messages car le RPx400 nécessite quatre périphériques USB (deux périphériques MIDI et deux
périphériques audio).

4. Sélectionnez Drivers USB Audio MIDI dans le menu. L'Installateur de Drivers USB du
RPx400 s’affiche.

REMARQUE : Si le câble USB n’est pas connecté, un message vous demandant de le
connecter s’affiche.Annulez l’installation, connectez le port USB du RPx400 à l’ordina-
teur et lancez à nouveau l’installation.

5. Une fois que le RPx400 est connecté, la fenêtre Installation matérielle s’affiche. Cliquez sur le
bouton Continuer quand même dans chacune des fenêtres qui apparaît.

6. Cliquez sur le bouton Terminer. L’installation du Driver USB du RPx400 est terminée.Vous êtes
prêt à utiliser le RPx400 pour enregistrer avec Pro Tracks.
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Windows 2000
1. Lancez l’ordinateur.
2. Insérez le CD X-Edit dans votre lecteur de CD. Le menu d’installation devrait s’afficher automati-

quement (dans le cas contraire, cliquez sur Démarrer>Lancer, cliquez sur Rechercher et
double-cliquez sur instmenu.exe sur le CD X-Edit).

3. Vous devez tout d’abord installer les Drivers USB correspondants pour utiliser la liaison USB avec
X-Edit et Pro Tracks. Assurez-vous que le RPx400 n’est PAS connecté à l’ordinateur.

4. Sélectionnez Drivers USB Audio MIDI dans le menu. L'Installateur de Drivers USB du
RPx400 s’affiche. Cliquez sur le bouton Suivant.

5. La fenêtre Digital Signature Not Found s’affiche. Cliquez sur le bouton Yes.
6. La fenêtre Digital Signature Not Found s’affiche à nouveau. Cliquez sur le bouton Yes.
7. La fenêtre RPx400 USB Driver Installer s’affiche. Cliquez sur le bouton Finish.
8. Connectez le câble USB fourni entre l’ordinateur et le RPx400. Plusieurs messages s’affichent, indi-

quant que votre ordinateur a trouvé un périphérique USB. Il y a plusieurs messages car le RPx400
nécessite quatre périphériques USB (deux périphériques MIDI et deux périphériques audio).

9. Une fois que le câble USB est connecté entre l’ordinateur et le RPx400, la fenêtre Digital
Signature Not Found s’affiche. Cliquez sur le bouton Yes.

10. La fenêtre Found New Hardware Wizard s’affiche. Cliquez sur le bouton Finish .
11. La fenêtre System Settings Change s’affiche. Cliquez sur le bouton No.
12. Une autre fenêtre Digital Signature Not Found s’affiche. Cliquez sur le bouton Yes.
13. Une autre fenêtre Found New Hardware Wizard s’affiche. Cliquez sur le bouton Finish.
14. Une autre fenêtre System Settings Change s’affiche. Cliquez sur le bouton No.
15. Une autre fenêtre Digital Signature Not Found s’affiche. Cliquez sur le bouton Yes.
16. Une autre fenêtre Found New Hardware Wizard s’affiche. Cliquez sur le bouton Finish.
17. Une autre fenêtre System Settings Change s’affiche. Cliquez sur le bouton No.
18. Une autre fenêtre Found New Hardware Wizard s’affiche. Cliquez sur le bouton Finish.
19. Une autre fenêtre System Settings Change s’affiche. Cliquez sur le bouton Yes. L’ordinateur

redémarre.

Vous êtes maintenant prêt à enregistrer avec Pro Tracks en utilisant le RPx400. Pour utiliser les fonctions
d’enregistrement du RPx400, lisez la section Utilisation de Pro Tracks de ce mode d’emploi.

Installation de l’éditeur/bibliothèque X-Edit
Une fois les Drivers USB installés, vous pouvez installer le logiciel X-Edit. Pour installer X-Edit, procédez
comme suit :
1. Revenez au menu d’installation (étape 2 de l’installation du Driver USB) et sélectionnez DigiTech X-

Edit.
2. L'Installateur cherche Microsoft .NET Framework sur votre ordinateur. S’il ne le trouve pas, l’installa-

teur .NET est lancé. Suivez les instructions.
3. Lorsque l’installateur .NET a terminé, le message Welcome to the Installation Wizard for

DigiTech X-Edit 1.0 s’affiche. Cliquez sur le bouton Next (Suivant).
4. Remplissez les informations client. Sélectionnez Anyone who uses this ordinateur pour permettre

à tous les utilisateurs d’avoir accès à X-Edit. Sélectionnez Only for me si vous souhaitez être le seul
utilisateur de X-Edit sur l’ordinateur. Cliquez sur le bouton Next.

5. Dans l’écran suivant, cliquez sur le bouton Install.
6. Lorsque l’installation est terminée, cliquez sur le bouton Finish.

Vous pouvez maintenant utiliser le logiciel d’édition/bibliothèque X-Edit avec le RPx400.

26

Le RPx400 en enregistrement



Connexion du RPx400 à l’ordinateur
Le RPx400 est fourni avec son câble USB pour la connexion à l’ordinateur, pour l’enregistrement ou l’uti-
lisation du logiciel X-Edit. Nous conseillons de n’utiliser que le câble USB fourni avec le RPx400. Pour
connecter le RPx400 à l’ordinateur, procédez comme suit :
1. Commencez avec le RPx400 hors tension.
2. Connectez la petite fiche du câble USB dans le port USB situé à l’arrière du RPx400.
3. Connectez la fiche plate du câble USB dans un port USB libre de l’ordinateur.
4. Placez le RPx400 sous tension.

Configuration du RPx400 pour l’enregistrement
Le RPx400 permet diverses configurations d’entrées/sorties, en fonction de vos besoins. Sélectionnez ces
configurations en utilisant les touches USB 1-2 Source et USB 3-4 Source du tableau d’effets du
RPx400. Il se peut que pour une session donnée, vous ayez besoin d’enregistrer la guitare avec les effets,
sans effet, un chant, une entrée ligne, voire de retraiter vos pistes de guitare non-traitées dans le RPx400.
Vous pouvez transférer un maximum de 4 canaux audio simultanément à l’ordinateur. Les touches de la
rangée SETUP sélectionnent comment et quels signaux audio sont routés vers la connexion USB.
Chaque source USB affecte une paire de signaux à l’ordinateur. Voici comment ces signaux sont
distribués :

USB 1-2 Source
STEREO — Toutes les sources d’entrée traitées par les effets du RPx400 sont transmises par USB 1 et 2.
MONO — Toutes les sources d’entrée traitées par les effets du RPx400 sont mélangées en mono et trans-

mises par USB 1.Aucune donnée n’est transmise par USB 2.
SUM+DG — Toutes les sources d’entrée traitées par les effets du RPx400 sont mélangées en mono et

transmises par USB 1. La guitare non traitée est transmise par USB 2.
SUMMIC — Toutes les sources d’entrée traitées par les effets du RPx400 sont mélangées en mono et

transmises par USB 1. Le signal du micro non traité est transmis par USB 2.
DGTR+M — La guitare non traitée est transmise par USB 1. Dry mic signal est transmise par USB 2.
drylin — Le signal Ligne gauche non traité est transmis par USB 1 et le signal Ligne droit non traité est

transmis par USB 2.
DRYGTR — La guitare non traitée est transmise par USB 1. Rien n’est transmis par USB 2.
DRYMIC — Le signal non traité du micro est transmis par USB 1. Rien n’est transmis par USB 2.
DRUMS — Les rythmes sont transmis par USB 1. Rien n’est transmis par USB 2.
REAMP — La lecture de Pro Tracks est transmise de l’ordinateur dans les effets du RPx400 et ensuite ren-

voyée par USB 1 et 2 pour être enregistrée. Voir Traitement d’une piste guitare en page 32.

USB 3-4 Source
USBOFF — USB 3 et 4 sont désactivés.
DGTR+M — La guitare non traitée est transmise par USB 3. Le signal du micro non traité est transmis par

USB 4.
drylin — Le signal Ligne gauche non traité est transmis par USB 3 et le signal droit non traité est trans-

mis par USB 4.
DRYGTR — La guitare non traitée est transmise par USB 3. Rien n’est transmis par USB 4.
DRYMIC — Le signal non traité du micro est transmis par USB 3. Rien n’est transmis par USB 4.
DRUMS — Les rythmes sont transmis par USB 3. Rien n’est transmis par USB 4.

Les illustrations des pages suivantes vous indiquent comment les signaux sont distribués par la liaison
USB : 27
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Affectation du signal guitare
Le signal de la guitare est routé de l’entrée aux effets du RPx400, puis aux paires de sorties. Le signal
transmis par USB peut être prélevé à l’entrée (USB Send A), ou en sortie des effets (USB Send C).
Les signaux enregistrés par USB Send A peuvent être traités plus tard par le RPx400.Voir Traitement
d’une piste guitare en page 32.

Organisation USB du signal de la guitare 
Le signal de la guitare possède deux trajets possibles pour la transmission par le port USB jusqu’à l’ordi-
nateur. Le trajet A prélève le son de la guitare directement en entrée et transmet le signal non traité au
port USB. Le trajet C prélève le son de la guitare en sortie du RPx400 et peut inclure tous les effets dis-
ponibles.Voici un tableau montrant où le signal est prélevé en fonction des réglages Mic, USB 1-2
Source et USB 3-4 Source :

Routage du signal du micro 
Le signal du micro peut être routé de différentes façons dans le RPx400. micoff désactive l’écoute de
l’entrée micro, mais permet l’enregistrement du signal non traité du micro. micdry route le signal du
micro sans les effets du RPx400 et le mélange aux sorties. micrvb route le signal du micro uniquement
traité par la réverbération et le délai du RPx400. micfx route le signal du micro par tous les effets du
RPx400.
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SC = Module de compensation de haut-parleur
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Organisation USB du signal du micro
Le signal du micro, comme vous avez pu le voir dans le schéma de routage précédent, offre deux trajets
de vers l’ordinateur par le port USB. Le trajet E prélève le signal du micro directement sur l’entrée et
transmet le signal non traité au port USB. Le trajet C prélève le signal du micro en sortie du RPx400 et
peut comprendre tous les effets disponibles.Voici un tableau montrant où le signal est prélevé en fonction
des réglages Mic, USB 1-2 Source et USB 3-4 Source :

Routage des signaux ligne 
Les signaux ligne, comme le signal du micro, peuvent être routés de diverses façon dans le RPx400.
linoff désactive l’écoute des entrées ligne, mais le signal non traité des entrées ligne peut être enregis-
tré. lindry route les signaux ligne gauche et droit sans les effets du RPx400 et les mélange aux sorties
gauche et droite. linrvb route les signaux ligne uniquement par les effets de délai et de réverbération
du RPx400. linefx mélange les voies gauche et droite des entrées ligne et affecte ce signal à tous les
effets du RPx400.

Organisation USB des signaux ligne
Les signaux d’entrée ligne, comme nous l’avons vu dans le schéma de routage précédent, offrent deux tra-
jets de routage à l’ordinateur par le port USB. Le trajet A prélève le signal des entrées ligne directement
sur les entrées et transmet le signal non traité au port USB. Le trajet B prélève ces signaux en sortie du
RPx400 et peut comprendre tous les effets disponibles.Voici un tableau montrant où le signal est prélevé
en fonction des réglages Line, USB 1-2 Source et USB 3-4 Source :
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Utilisation de Pro Tracks
Lorsque vous lancez Pro Tracks pour la première fois après installation, vous devez configurer les réglages de
périphérique MIDI et audio pour que le RPx400 soit reconnu comme le périphérique à utiliser. Ces procé-
dures doivent être scrupuleusement suivies afin de pouvoir enregistrer les signaux audio du RPx400 et per-
mettre l’automatisation offerte par le RPx400.

REMARQUE : Consultez la fiche d’installation fournie avec le RPx400 (sur l’installation des
Drivers USB), avant de connecter le RPx400 à votre ordinateur et d’utiliser Pro Tracks.

Installation de Pro Tracks
Vous devez installer Pro Tracks sur votre ordinateur pour exploiter les possibilités d’enregistrement du
RPx400. Pour installer Pro Tracks, consultez les instructions d’installation fournies avec le CD d’installation
de Pro Tracks.

Configuration du périphérique MIDI du RPx400 
Le RPx400 utilise des commandes MIDI pour communiquer avec Pro Tracks. Ces commandes sont utili-
sées pour déterminer quels réglages USB 1-2 Source et USB 3-4 ont été sélectionnés, de sorte que Pro
Tracks puisse fonctionner correctement lorsque vous utilisez les commandes au pied du RPx400. Pour
configurer les réglages MIDI de Pro Tracks pour fonctionner avec le RPx400, procédez comme suit :

1. Lancez Start Pro Tracks sur votre ordinateur.
2. Si la fenêtre Tip of the Day s’affiche, cliquez sur le bouton Close.
3. Si aucune sortie MIDI n’a encore été sélectionnée, la fenêtre No MIDI Outputs Selected s’affiche.

Cliquez sur le bouton Choose MIDI Outputs Now. La fenêtre MIDI Devices s’ouvre.
4. Dans les zones Input et Output, sélectionnez RPx400 USB MIDI. Ne pas sélectionner DigiTech USB

X-Edit ou toute autre option. Cliquez sur le bouton Move Selected Devices to Top.
5. Cliquez sur le bouton OK — la fenêtre se ferme.
6. Si la fenêtre Quick Start s’ouvre, cliquez sur le bouton Close.

Configuration du RPx400 pour activer les commandes au pied
1. Depuis la barre de menus de Pro Tracks, sélectionnez Options>Control Surfaces. La fenêtre

Control Surfaces s’affiche.
2. Cliquez sur le bouton + pour ajouter un nouveau contrôleur. La fenêtre Control Surface Settings

s’ouvre.
3. Dans le menu déroulant Control Surface, sélectionnez DigiTech RPx.Vérifiez que les réglages de

ports Input et Output indiquent toujours RPx400 USB MIDI. Dans le cas contraire, rectifiez.
4. Cliquez sur le bouton OK. DigiTech RPx doit maintenant être sélectionné comme contrôleur de la

zone Control Surfaces.
5. Cliquez sur le bouton Close.

Pro Tracks peut maintenant répondre au RPx400 pour les fonctions d’enregistrement automatisées.

Configuration de Pro Tracks pour les signaux audio du RPx400
1. Dans la barre de menu de Pro Tracks, sélectionnez Options>Audio. Le fenêtre Audio Options s’af-

fiche. Cliquez sur l’onglet Drivers.
2. Dans les réglages Input Drivers, sélectionnez DigiTech USB 1-2 In/Out et DigiTech USB 3-4 In

Only et désélectionnez toutes les autres options.30
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3. Dans la zone Output Drivers, sélectionnez DigiTech USB 1-2 In/Out et désélectionnez toutes les
autres options.

4. Cliquez sur le bouton OK.
5. Cliquez sur le bouton OK de la fenêtre de sauvegarde des réglages lors du prochain démarrage.
6. Fermez Pro Tracks. Lorsque le logiciel vous demande de sauvegarder les modifications, cliquez sur No.
7. Relancez Pro Tracks.
8. Fermez les fenêtres Tip of the Day et Quick Start si elles apparaissent.
9. Dans la barre de menu de Pro Tracks, sélectionnez Options>Audio.

10. Vérifiez si les réglages Playback et Record Timing Master indiquent DigiTech USB 1-2 In/Out.
Sinon, sélectionnez-les maintenant.

11. Cliquez sur le bouton Wave Profiler (en bas).
12. Cliquez sur le bouton Yes pour continuer les tests.
13. Lorsque l’opération d’auto-test est terminée, cliquez sur le bouton OK.
14. Cliquez sur le bouton OK pour fermer la fenêtre Audio Options si elle est toujours ouverte.

Vous êtes maintenant prêt à utiliser le RPx400 avec Pro Tracks.

ATTENTION : Ne pas déconnecter l’alimentation ou le câble USB du RPx400 ou de l’ordi-
nateur pendant que Pro Tracks tourne. Ceci pourrait déstabiliser le système d’exploitation
de votre ordinateur.

Utilisation des pédales du RPx400 en enregistrement
Vous pouvez utiliser les pédales du RPx400 pour contrôler Pro Tracks™, ce qui vous permet d’enregistrer
tout en jouant.Vous devez relier le RPx400 à l’ordinateur par le câble USB fourni. Pro Tracks doit être installé
et tourner.

Enregistrement d’une ou plusieurs pistes
Pour enregistrer une piste en utilisant les pédales, procédez comme suit :

1. Lancez Pro Tracks.
2. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’affiche.
3. Dans la fenêtre New Project File, sélectionnez Normal — Hands-Free Session.
4. Placez les pédales du RPx400 en mode d’enregistrement en maintenant les pédales HAUT et AMP

A/B enfoncées, jusqu’à ce que l’écran affiche rec fs.
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5. Dans l’écran des Presets, maintenez la touche SELECT enfoncée pour passer sur la rangée SETUP
du tableau des effets du RPx400. Sinon, appuyez sur la touche SELECT jusqu’à ce que la rangée Setup
soit sélectionnée.

6. Sélectionnez les sources à enregistrer à l’aide du bouton USB 1-2 Source (vous pouvez sélectionner
d’autres sources à l’aide de la touche USB 3-4 Source).

7. Appuyez sur la pédale RECORD. L’écran affiche record. Une ou plusieurs pistes sont
automatiquement insérées dans la session courante de Pro Tracks et l’enregistrement sur ces pistes
commence.

8. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO. L’écran du RPx400 indique stop
et Pro Tracks cesse l’enregistrement.Vous pouvez maintenant consulter les pistes enregistrées sur
votre ordinateur.

Lecture d’une piste enregistrée
Si vous souhaitez lancer la lecture depuis le début de la piste ou du morceau, et si vous n’êtes pas à la fin
du morceau, procédez comme suit :

1. Appuyez sur la pédale STOP/UNDO. L’écran du RPx400 affiche rewind. Pro Tracks revient au
début du morceau.

2. Appuyez sur la pédale PLAY. Les pistes enregistrées sont lues.

Enregistrement de plusieurs pistes
Vous pouvez enregistrer des pistes supplémentaires tout en écoutant les pistes déjà enregistrées.
Procédez comme suit :

1. Dans l’écran Preset, maintenez la touche SELECT enfoncée pour passer sur la rangée SETUP du
tableau d’effets du RPx400.

2. Sélectionnez les sources à enregistrer à l’aide de la touche USB 1-2 Source (vous pouvez
sélectionner d’autres sources à l’aide de la touche USB 3-4 Source).

3. Appuyez deux fois sur la pédale STOP/UNDO pour revenir au début du morceau.
4. Appuyez sur la pédale RECORD. L’écran affiche record. La, ou les pistes, sont automatiquement

insérées dans la session de Pro Tracks et l’enregistrement de ces pistes commence.
5. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.

Utilisation de la pédale UNDO pour effacer une piste
Vous pouvez annuler la dernière prise comme suit :

1. Maintenez la pédale STOP/UNDO enfoncée. Le RPx400 affiche undo, indiquant que la/les dernières
pistes enregistrées sont effacées.

Traitement post-enregistrement d’une piste de guitare
En utilisant l’une des configurations Dry Guitar pour l’enregistrement, vous pouvez lire la piste de guitare
non-traitée dans le RPx400 pour traitement. Ceci vous permet d’enregistrer la guitare en son clair et de
décider lors du mixage des effets à lui appliquer (modèle d’ampli, effets, etc.). Ceci vous permet d'adapter
le son et le style de la guitare au morceau, une fois celui-ci terminé et prêt pour le mixage final.
Pour traiter une piste de guitare enregistrée sans effets :
1. Placez les pédales du RPx400 en mode d’enregistrement en maintenant les pédales HAUT et AMP

A/B enfoncées, jusqu’à ce que l’écran affiche rec fs.
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2. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’ouvre.
3. Sélectionnez le fichier Normal-Hands Free Session.
4. Sélectionnez la rangée SETUP du tableau d’effets du RPx400.
5. Utilisez la touche USB 1-2 Source pour sélectionner drygtr et placez USB3-4 Source sur off.
6. Appuyez sur la pédale RECORD. L’écran du RPx400 affiche record. Une piste est automatiquement

insérée dans la session de Pro Tracks et l’enregistrement de cette piste commence.
7. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO. Le RPx400 affiche stop et

l’enregistrement cesse.Appuyez à nouveau sur la pédale Stop pour revenir au début de la piste.
8. Dans la boîte Out de la piste que vous venez d’enregistrer, sélectionnez B (Digitech USB 1-2

In/Out).

9. Dans la barre d’outils, appuyez sur Console View pour afficher la console de mixage.

10. Placez B — Mains Output complètement à gauche et A — Mains Output complètement à
droite.

11. Sélectionnez à nouveau la rangée SETUP et utilisez la touche USB 1-2 Source pour sélectionner
REAMP. Ceci configure le logiciel en lecture audio par les effets du RPx400.

12. Appuyez sur la pédale PLAY. Placez les pédales en mode de jeu normal en maintenant les pédales
UP et AMP A/B enfoncées jusqu’à ce que l’écran indique updown. Vous pouvez maintenant écouter
les Presets jusqu’à en trouver un qui vous plaise. Repassez alors en mode d’utilisation des pédales
pour l’enregistrement.

13. Appuyez deux fois sur la pédale STOP/UNDO pour revenir en début de piste.
14. Appuyez sur la pédale RECORD — l’enregistreur insère et enregistre alors une piste stéréo de

guitare traitée.
15. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.
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RPx400 Drums et MIDI
Les échantillons de la boîte à rythmes du RPx400 sont organisés de sorte que vous puissiez les déclencher
depuis les notes MIDI jouées par Pro Tracks. Chaque Pattern rythmique du RPx400 a été programmé comme
piste MIDI dans les fichiers de Pro Tracks.

Affectation MIDI des échantillons de batterie du RPx400 :
Note MIDI Échantillon
36/C3  . . . . . . . . . . . . .Grosse caisse
38/D3  . . . . . . . . . . . . .Caisse claire
42/F#3  . . . . . . . . . . . .Charleston fermé
46/Bb3  . . . . . . . . . . . .Charleston ouvert

Enregistrement des sons de la boîte à rythmes du RPx400
Les sons de la boîte à rythmes du RPx400 peuvent être enregistrés par Pro Tracks. Chaque Pattern ryth-
mique du RPx400 a été sauvegardé dans un fichier que vous pouvez sélectionner avec l’assistant bibliothé-
caire de Pro Tracks et que vous pouvez utiliser pour lire ces échantillons dans le RPx400. Pour enregistrer
les sons de batterie du RPx400 en utilisant les fichiers de Pattern de Pro Tracks, procédez comme suit :

1. Dans Pro Tracks, sélectionnez File>New. La fenêtre New Project File s’affiche.
2. Sélectionnez l’un des fichiers de Pattern DigiTech RPx400 et cliquez sur OK. Une nouvelle session

d’enregistrement s’ouvre.
3. Sur le RPx400, utilisez les touches USB 1-2 Source ou USB 3-4 Source pour sélectionner drums.
4. Appuyez sur la pédale RECORD. Le RPx400 affiche record. Une nouvelle piste est

automatiquement insérée dans la session courante de Pro Tracks et l’enregistrement sur ces pistes
commence.

5. Pour arrêter l’enregistrement, appuyez sur la pédale STOP/UNDO.

Vous pouvez utiliser des fichiers MIDI de Patterns de batterie pour déclencher les sons du RPx400, tant
que les notes MIDI sont organisées pour déclencher les bons corrects. Les sons de batterie du RPx400
répondent uniquement aux messages MIDI transmis sur le canal 10, qui est le canal par défaut des fichiers
au format General MIDI.

Mixage de la lecture
Le bouton LECTURE MIX vous permet de mixer facilement le traitement du RPx400 avec la lecture des
pistes de Pro Tracks. Cette fonction est uniquement disponible lorsque le RPx400 est connecté à l’ordinateur
par liaison USB et que Pro Tracks est chargé. Pour modifier le niveau de lecture du RPx400, procédez comme
suit :

1. Lancez la lecture de la session sur Pro Tracks.
2. Tournez le bouton Playback Mix pour équilibrer le niveau de traitement de la guitare du RPx400 avec la

lecture. Lorsque l’écran indique USBMIX, cela signifie que seuls les signaux du RPx400 peuvent être enten-
dus.Tournez le bouton vers la droite pour augmenter le niveau de la lecture. USBRPX50 indique que le
niveau RPx400/son de l’ordinateur est réglé sur 50/50.Tournez encore vers la droite pour diminuer le
niveau du RPx400. RPxMIX indique que seule la lecture de l’ordinateur est entendue.
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Boutons USB 1-2 Level / USB 3-4 Level
Les boutons USB 1-2 LEVEL et USB 3-4 LEVEL servent à doser le niveau des signaux transférés à l’ordi-
nateur par le port USB. Ces réglages sont utilisés lorsque le niveau du signal de la source d’entrée (micro,
ligne, guitare) n’est pas optimisé dans votre logiciel d’enregistrement (consultez le mode d’emploi de Pro
Tracks pour obtenir de plus amples renseignements sur les réglages de niveau). Si le niveau du signal est trop
élevé pour Pro Tracks, utilisez ces réglages pour diminuer le niveau. Les boutons USB 1-2 Level et USB 3-4
Level contrôlent le niveau de chaque paire de sorties USB. Par exemple, si summic est la source USB 1-2
Source sélectionnée, le fait d’augmenter le niveau du micro de 6 dB sur la sortie USB 2 augmente également
le niveau total de 6 dB sur la sortie USB 1. Pour augmenter ou atténuer le niveau du signal audio transféré à
l’ordinateur, procédez comme suit :

1. Jouez ou chantez dans le RPx400 et contrôlez le niveau du signal en entrée du logiciel d’enregistrement
(consultez le mode d’emploi de Pro Tracks pour obtenir de plus amples renseignements sur l’affichage des
niveaux d’enregistrement).

2. Utilisez le bouton USB Level correspondant pour augmenter ou atténuer le niveau du signal transféré au
logiciel d’enregistrement. La plage d’atténuation/amplification est de -6 dB (usb1-2 -6) à +24 dB (usb1-
2 24).

Utilisation du pédalier RPxFC pour l’enregistrement

Le RPx400 dispose d’une embase située en face arrière et vous permettant de connecter un pédalier RPxFC
optionnel. Ceci vous permet de commander les fonctions d’enregistrement du RPx400. Ce triple pédalier
permet de commander les fonctions STOP/UNDO, RECORD et PLAY au pied. Le pédalier RPxFC est
parfait pour l’enregistrement car il libère les pédales du RPx400 pour les changements de Presets et la
commutation des canaux d’amplificateur. Le RPxFC est alors utilisé uniquement pour contrôler le logiciel Pro
Tracks. Utilisez uniquement un câble Jack 6,35 mm stéréo pour connecter le RPxFC au RPx400.

Les fonctions du RPxFC sont identiques à celles des pédales du RPx400 lorsque vous êtes en mode
d’enregistrement. Consultez la section Utilisation des pédales du RPx400 pour l’enregistrement.

FOOT CONTROLLERFOOT CONTROLLERFOOT CONTROLLER

STOP/UNDO RECORD PLAY
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Utilitaires
Initialisation d’usine
Cette fonction permet de reconfigurer le RPx400 sur ses réglages d’usine. Cette procédure efface tous les
Presets utilisateur et recalibre la pédale d’expression.

ATTENTION : Cette fonction efface toutes les données programmées par l’utilisateur.Assurez-
vous que vous souhaitez effacer toutes vos données avant de lancer cette procédure.

la procédure d’initialisation est la suivante :
1. Déconnectez l’alimentation du RPx400.
2. Maintenez la touche Select enfoncée pendant la remise sous tension du RPx400.
3. Lorsque l’écran affiche rst  ?, relâchez la touche Select et appuyez sur la touche Store dans les

5 secondes. L’écran affiche reset, indiquant que le RPx400 est revenu à ses réglages d’usine. Le RPx400
passe alors automatiquement au calibrage de la pédale d’expression. Suivez les étapes 4 à 7 de la section
sur le calibrage de la pédale d’expression.

Calibrage de la pédale d’expression
La pédale d’expression doit être recalibrée après une initialisation sur les réglages d’usine. Cette fonction s’af-
fiche automatiquement après une initialisation. Dans le cas où le calibrage viendrait à échouer, ou si la pédale
ne fonctionne pas correctement, utilisez la fonction de calibrage. Ceci n’efface pas les Presets utilisateur. La
procédure de calibrage de la pédale est la suivante :
1. Déconnectez l’alimentation PS0913B à l’arrière du RPx400.
2. Maintenez la pédale BAS enfoncée lors de la mise sous tension.
3. Maintenez la pédale BAS enfoncée jusqu’à ce que l’écran affiche calib.
4. Lorsque l’écran affiche TOE DN, placez la pédale en position basse.
5. Appuyez sur n’importe quelle pédale. L’écran affiche toe up.
6. Placez la pédale en position haute.
7. Appuyez sur n’importe quelle pédale. L’écran affiche VSWTCH, indiquant que vous venez d’entrer dans le

menu de réglage de sensibilité du V-Switch.
8. Si vous ne souhaitez pas régler la sensibilité du V-Switch, appuyez sur n’importe quelle pédale pour revenir

en mode de jeu.
Remarque : Si Error s’affiche, reprenez les étapes 4 à 8.

Sensibilité du V-Switch
Si vous souhaitez régler la sensibilité du V-Switch, suivez les étapes 1 à 7 du calibrage de la pédale d’expres-
sion, puis procédez comme suit :
1. Lorsque l’écran affiche VSWTCH, placez la pédale d’expression en position basse et appuyez jusqu’à ce que

l’écran affiche DONE.
2. Lorsque l'écran clignote entre DONE (avec la sensibilité du V-Switch affichée) et VSWTCHOn (ou VSWTCHOf,

selon si le V-Switch est actif ou inactif), vous pouvez contrôler la sensibilité du V-Switch en appliquant la
pression sur la position basse de la pédale d’expression.

3. Tournez le bouton 5 pour modifier la valeur de sensibilité du V-Switch.Vous pouvez contrôler la nouvelle
valeur en appliquant la pression sur la pédale d’expression, en position basse.

4. Une fois la valeur de sensibilité sélectionnée, appuyez sur n’importe quelle pédale. Le RPx400 repasse en
mode de jeu et vos réglages sont automatiquement sauvegardés.
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Assistance technique
La lecture audio de Pro Tracks comprend des bruits de pop et de clic.

•  Essayez le Wave Profiler dans Options->Audio. Ceci semble résoudre la majorité des problèmes. Dans le cas
contraire, essayez d’utiliser les Drivers MME dans Options->Audio->Advanced, Driver Mode. Ce sont les
Drivers les plus communs, mais également ceux qui offrent le temps de latence le plus élevé.

•  Essayez d’augmenter la valeur de latence dans les réglages audio.

Les commandes d’enregistrement au pied du RPx 400 ne fonctionnent pas, ou plus.
•  Si elles fonctionnaient, essayez de quitter Pro Tracks et de le relancer (sauvegardez avant !).
•  Placez le RPx 400 hors et sous tension avant de lancer Pro Tracks ou X-Edit.
•  Si les commandes n’ont jamais fonctionné, il y a un problème de MIDI USB.Vous utilisez les mauvais Drivers

et/ou .dll ou ils sont mal installés. Un câble USB défectueux peut en être aussi la cause.
•  Consultez la section sur l’installation des Drivers.

Lecture impossible depuis Pro Tracks.
•  Si le mode de traitement des pistes par le RPx 400 est actif, changez de mode.
•  Assurez-vous que les Faders de Pro Tracks ne sont pas au minimum.
•  Vérifiez que les pistes ne sont pas coupées (Mute).
•  Accédez au menu Options->Audio->Drivers et dans Output Drivers, sélectionnez ‘DigiTech USB 1-2

In/Out’ et désélectionnez toute autre option.
•  Consultez la section sur l’installation des Drivers.

Le RPx 400 n’enregistre pas dans Pro Tracks.
•  Accédez au menu Options->Audio->Drivers et dans Output Drivers, sélectionnez ‘DigiTech USB 1-2

In/Out’ et ‘DigiTech USB 3-4 In Only’ et désélectionnez toute autre option.
•  Assurez-vous que vous avez installé les bons Drivers.
•  Consultez la section sur l’installation des Drivers.
•  Pour la première piste, assurez-vous que le mode ‘Reamp’ du RPx 400 n’est pas utilisé.

Je n’arrive pas à traiter mes pistes enregistrées dans le RPx400.
•  Consultez la section sur le Traitement des pistes enregistrées par RPx400 de ce mode d’emploi.

Pro Tracks se bloque.
•  Fermez tous les programmes autres que Pro Tracks. Contrôlez le Gestionnaire de tâches, et assurez-vous qu’il

n’y a pas une application cachée qui tourne en fond.
•  Essayez de réduire le nombre de Plug-ins et de synthés virtuels.
•  Augmentez la mémoire de votre système.
•  Procurez-vous un disque dur plus rapide.
•  Sauvegardez vos données audio sur un disque dur différent de celui sur lequel est installé le système d’exploita-

tion et vos applications.
•  Utilisez un ordinateur plus rapide.
•  Consultez la section sur les systèmes requis.

Où sont mes fichiers Wave ?
•  Les fichiers Wave sont tous sauvegardés dans le répertoire spécifié dans Options->Global, Audio Data.

Le volume de mes fichiers Wave est trop élevé/bas.
•  Vous pouvez modifier le niveau d’enregistrement à l’aide des boutons USB1-2 et USB3-4 Level.

Le niveau de lecture de Pro Tracks est supérieur à celui de ma guitare.
•  Vous pouvez régler le mixage de lecture avec le bouton Playback Mix. 37
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J’ai des décrochages audio en enregistrement.
•  Essayez d'augmenter le temps de latence dans les réglages Audio.
•  Essayez de réduire le nombre de pistes de votre projet (le faite de Muter les pistes ne change rien.Vous devez

archiver les pistes ou les effacer).
•  Fermez tous les programmes autres que Pro Tracks. Contrôlez le Gestionnaire de tâches, et assurez-vous qu’il n’y a

pas une application cachée qui tourne en fond.
•  Essayez de réduire le nombre de Plug-ins et de synthés virtuels.
•  Augmentez la mémoire de votre système.
•  Procurez-vous un disque dur plus rapide.
•  Sauvegardez vos données audio sur un disque dur différent de celui sur lequel est installé le système d’exploitation

et vos applications.
•  Utilisez un ordinateur plus rapide.

Lorsque je lance X Edit, il ne trouve pas le RPx 400.
•  Assurez-vous que vos Drivers sont correctement chargés et que le câble USB est correctement connecté.
•  Consultez la section sur l’installation des Drivers.

La lecture est doublée.
•  L’écoute des entrées est probablement active. Désactivez dans Options->Audio->Input Monitoring.

Les réglages Bass, Mid et Treble ne fonctionnent pas.
•  Avec la connexion USB, les réglages Bass, Mid et Treble contrôlent les fonctions Playback Mix, USB 1-2 Level, et

USB 3-4 Level. Utilisez le tableau d’édition ou le logiciel X Edit pour régler les graves, médiums et aigus.

Je n’arrive pas à enregistrer au micro.
•  Vous pouvez enregistrer le micro sans traitement, uniquement sur une piste individuelle et non dans un mixage.

Sélectionnez Setup dans le tableau d’effets et sélectionnez MICDRY dans USB1-2 Source ou USB3-4 Source.
•  Vous pouvez enregistrer le micro avec réverbération ou effets avec le mixage guitare. La configuration du micro

doit être réglée sur MICRVB ou MIC FX.

Je n’arrive pas à enregistrer mes sons de batterie.
•  La batterie peut être enregistrée uniquement sur une piste séparée, et non dans le mixage. Pour enregistrer la bat-

terie, sélectionnez Setup dans le tableau et sélectionnez Drums dans USB1-2 Source ou USB3-4 Source.

Je n’arrive pas à enregistrer mes entrées ligne.
•  Vous pouvez enregistrer les entrées ligne sans traitement uniquement sur une piste individuelle et non dans un

mixage. Sélectionnez Setup dans le tableau d’effets et sélectionnez DRYLIN in USB1-2 Source ou USB3-4
Source.

•   Vous pouvez enregistrer les entrées ligne avec réverbération ou effets avec le mixage guitare. La configuration des
entrées ligne doit être réglée sur LINRVB ou LINEFX.

j’ai des décrochages lorsque je change de Preset lors de l’enregistrement ou de la lecture.
•  Ne changez pas de Preset lors de l’enregistrement ou de la lecture.

j’ai des décrochages sur mes entrées micro/ligne lorsque j’enregistre.
•  Ne changez pas de Preset lors de l’enregistrement.

Pro Tracks ne démarre pas.
•  Il y a sûrement eu une interruption de connexion USB lors de la session précédente de Pro Tracks.Vous devez

redémarrer votre système pour résoudre ce problème.

Je n’entends pas la lecture de la liaison USB 3-4.
•  La lecture n’est possible qu’avec USB1-2. USB3-4 ne servent qu’à l’enregistrement.
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Annexes 
Listes de paramètres de contrôleurs continus (CC)
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CC Paramètre
4 EXPRESSION PEDAL CONTROL
7  MASTER LEVEL

18 COMP ON/OFF
19 COMP ATTACK
20 COMP RATIO 
21 COMP THRESH 
22 COMP GAIN          
23 AMP CHANNEL       
24 AMP A TYPE        
25 AMP A GAIN         
26 AMP A LEVEL        
27 CAB A MIC          
28 AMP B TYPE         
29 AMP B GAIN         
30 AMP B LEVEL      
31 CAB B MIC          
32 EQ A ON/OFF       
33 EQ A LOW         
34 EQ A MIDFREQ     
35 EQ A MID           
36 EQ A HIGH         
37 EQ B ON/OFF      
38 EQ B LOW           
39 EQ B MIDFREQ      
40 EQ B MID           
41 EQ B HIGH        
42 GATE ON/OFF         
43 GATE TYPE          
44 GATE ATTACK        
45 GATE THRESH        
46 GATE SENS          
47 FX ON/OFF          
48 FX TYPE           
49 FX PARAM1      
50 FX PARAM2      

CC Paramètre
51 FX PARAM3      
52 FX LEVEL         
53 DLY ON/OFF     
54 DLY TYPE         
55 DLY TIME         
56 DLY FEEDBACK
57 DLY LEVEL       
58 RVB ON/OFF     
59 RVB TYPE         
60 RVB PREDELAY 
61 RVB DECAY          
62 RVB DAMP           
63 RVB LEVEL          
75 MIC ROUTING
76 LINE ROUTING
77 USB1-2 SOURCE
78 USB3-4 SOURCE
79 SPEAKER COMPENSATION
80 USB1-2 LEVEL
81 USB3-4 LEVEL
82 PLAYBACK MIX
102 WAH POSITION
103 PDL ASSIGN      
104 PDL MIN           
105 PDL MAX          
106 LFO1 ASSIGN    
107 LFO1 MIN         
108 LFO1 MAX        
109 LFO1 SPEED      
110 LFO2 ASSIGN    
111 LFO2 MIN         
112 LFO2 MAX        
113 LFO2 SPEED       
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Liste des Presets d’usine

Numéro Preset Nom affiché Nom affichéNuméro Preset
F 1 F 21
F 2 F 22
F 3 F 23
F 4 F 24
F 5 F 25
F 6 F 26
F 7 F 27
F 8 F 28
F 9 F 29
F 10 F 30
F 11 F 31
F 12 F 32
F 13 F 33
F 14 F 34
F 15 F 35
F 16 F 36
F 17 F 37
F 18 F 38
F 19 F 39
F 20 F 40

Numéro Artiste Nom affiché Nom affichéNuméro Preset
U/A 1 U/A 21
U/A 2 U/A 22
U/A 3 U/A 23
U/A 4 U/A 24
U/A 5 U/A 25
U/A 6 U/A 26
U/A 7 U/A 27
U/A 8 U/A 28
U/A 9 U/A 29
U/A 10 U/A 30
U/A 11 U/A 31
U/A 12 U/A 32
U/A 13 U/A 33
U/A 14 U/A 34
U/A 15 U/A 35
U/A 16 U/A 36
U/A 17 U/A 37
U/A 18 U/A 38
U/A 19 U/A 39
U/A 20 U/A 40

James Fukai Evil D
Dan Donegan Joey Z
Dan Donegan Joey Z
Jennifer Batten Metal Mike Chlasciak
Jennifer Batten Metal Mike Chlasciak
Mike Einziger Metal Mike Chlasciak
Mike Einziger Michael Wilton
Clint Lowery Michael Wilton
Clint Lowery Marc Rizzo
Clint Lowery Andy LaRocque
Chad Kroeger Andy LaRocque
Chad Kroeger Dave Murray

Dave MurrayCarlos Cavaso
Dave MurrayCJ Pierce
Dave MurrayCJ Pierce
Paul CrookCJ Pierce
Paul CrookDominic Cifarelli
Acey SladeGlen Drover
Glenn TiptonJody Payne

Evil D Glenn Tipton

jfukai

Dan 1

dan 2

lqdled

dukpnd

incubs

incub2

7dust1

7dust2

7dust3

chadnb

chadn2

cavaso

cjtxfl

cjtxtn

cjtxml

cifrli

drover

jody

bloat

Lush

Joeyz

whipit

mtlmke

warcry

rip

crhled

chunk

illriz

rhythm

solo

clnsrm

dabluz

da std

pdldrv

crkflg

crkwhy

acey

tipton

tiptn2
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Caractéristiques techniques :

41

Entrées :
Guitar In : Jack 6,35 mm asymétrique 
Mic In : XLR symétrique avec alimentation fantôme
Line In : Jack stéréo 6,35 mm symétrique 
CD/Monitor : Jack stéréo 3,5 mm 
Footswitch : Jack stéréo 6,35 mm 
USB : Version 1.1

Sorties :
Line : Jack 6,35 mm asymétrique 
Line : XLR symétrique 
Headphone : Jack stéréo 3,5 mm 
USB : Version 1.1

Conversion A/N/A :
24 bits, Delta Sigma

Fréquence d’échantillonnage :
44,1 kHz

Boîte à rythmes :
30 Patterns + métronome 

Effets de simulation :
11 maximum

Consommation électrique :
10 Watts 

Débit en courant :
675 mA, tension alternative 

Adaptateurs secteur :
9 Vca, 1,3 A 
DigiTech PS0913B — 100 (100 V~ 50/60 Hz)
DigiTech PS0913B — 120 (120 V~ 60 Hz)
DigiTech PS0913B — 230 (230 V~ 50 Hz)
DigiTech PS0913B — 240 (240 V~ 50 Hz)

Presets :
40 Presets utilisateur
40 Presets Artiste (usine)
40 Presets usine 

Effets :
Pickup Simulator,Wah, Compressor,Amp et Acoustic Guitar Models, 3 band EQ, Noise Gate,Auto Swell, Pluck Gate, Cabinet
Modeling, Mic Placement, Chorus, Flange,Triggered Flange, Phaser,Triggered Phaser,Tremolo, Panner,Vibrato, Rotary Speaker,
AutoYa™,YaYa™, SynthTalk™, Envelope Filter, Pitch Shift, Detune,Whammy™, Delay et Reverb.

Dimensions :
216 mm (p) x 330 mm (l) x 57 mm (h)

Poids :
2,2 kg  
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